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2 I N S T A L L A T I O N G U I D E

Introduction
Use this manual to install Business Portal for Microsoft Dynamics® GP 2010. This 
documentation contains information about installing and configuring your system.

Check for updated instructions
This information was current as of November 1, 2010. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
documentation web site (http://go.microsoft.com/fwlink/?LinkId=185513) for the 
most current documentation.

163279

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Additional resources
• Technical support
• Send us your documentation comments

What’s in this manual

This manual provides step-by-step instructions for installing and deploying 
Business Portal in your organization. It includes the following parts:

• Part 1, Preparation, lists the supported configurations for Business Portal and 
contains a checklist to guide you through the installation process.

• Part 2, Network and server configuration, explains how your network should 
be configured to run Business Portal. It also contains procedures for setting up 
your SQL Server and web server for Business Portal.

• Part 3, Business Portal installation, contains the procedures for installing 
Business Portal and its prerequisites.

• Part 4, Additional setup, explains how to set up Reports Catalog in Business 
Portal, how to set up Terminal Services for Business Portal, and how to set up 
Business Portal client computers.

• Part 5, Extranet deployment, describes supported extranet configurations and 
provides recommended settings to run Business Portal in an extranet 
environment.

• Appendix A, “Demonstration or development configuration,” explains how to 
install Business Portal on a single computer for demonstration or development 
purposes.

http://go.microsoft.com/fwlink/?LinkId=185513
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I N T R O D U C T I O N

Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation, and 
other information.

Additional resources

In addition to this manual, the following documentation is included with this 
release of Business Portal.

Manuals
The following PDF manuals are included in the Documentation folder on the 
Business Portal installation media.

After you’ve installed Business Portal, you can find links to these manuals and 
other printable Business Portal documentation in the Documentation Resources 
web part on the Administration Resources page. (On the top-level Business Portal 
site, click Administration.)

Business Portal Administrator’s Guide The Administrator’s Guide 
(BusinessPortalAdminGuide.pdf) explains how to set up and configure Business 
Portal.

Business Portal User’s Guide The User’s Guide 
(BusinessPortalUsersGuide.pdf) helps users complete day-to-day tasks in Business 
Portal.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and suggestions.

The warning symbol indicates situations you should be especially aware 
of when completing tasks. Typically, this includes cautions about 
performing steps in their proper order, or important reminders about 
how other information in Business Portal or Microsoft Dynamics GP may 
be affected.

Convention Description

Install Business Portal Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as choosing items 
from a menu, toolbar, or palette. This example directs you to go to the 
File menu and click Print.

Bold Bold type indicates navigation, tab names, menus, commands, buttons, 
field names, keywords, and functions.

TAB or ENTER Small capital letters indicate a key or a key sequence.

Business Data Catalog 
is available only if 
you’re using Business 
Portal with Office 
SharePoint Server 
2007, Enterprise 
Edition

Margin notes indicate when a topic applies only if you’re using a specific 
product or technology.
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Application manuals User and Administrator manuals for each application 
installed in Business Portal are available in the Documentation folder.

Help
Help is available by clicking the Help icon button, located in the upper-right corner 
of any page. The help that is displayed depends on whether you open help from a 
Business Portal page or a SharePoint® page.

Business Portal help When you click the Help icon button on a Business Portal 
page, the relevant help topic for that page is displayed. You can use the search field 
on the help page to search for information. You also can click the Home icon button 
to browse the contents of the help.

SharePoint help  Many of the features included in Business Portal—such as 
document libraries, lists, announcements, links, and alerts—are provided by 
Windows SharePoint Services. General information about these features is provided 
in the Administering Business Portal help. For more detailed information, refer to 
the Windows SharePoint Services help, which can be accessed by clicking the Help 
icon button in the upper-right corner of any Windows SharePoint Services page. If 
you’re using Office SharePoint Server 2007, additional help related to the 
SharePoint Server features also will be available.

Technical support

You can contact Microsoft Dynamics GP Technical Support online or by telephone. 
Go to www.microsoft.com/dynamics and click the CustomerSource link or call 888-
477-7877 (in the U.S. and Canada) or 701-281-0555.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

http://www.microsoft.com/dynamics
mailto:bizdoc@microsoft.com
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6 I N S T A L L A T I O N G U I D E

Part 1: Preparation
This part of the documentation provides an overview of the Business Portal 
installation and contains information about supported configurations for Business 
Portal. A checklist to guide you through the installation process is also included.

The following information is discussed:

• Chapter 1, “Installation overview,” provides an overview of the software 
configuration for Business Portal, explains the site hierarchy, and includes an 
installation checklist.

• Chapter 2, “Business Portal configurations,” describes supported server 
configurations for Business Portal.
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Chapter 1: Installation overview
This chapter provides an overview of the Business Portal installation process. The 
following sections are included:

• Business Portal installation overview
• Windows SharePoint Services vs. Office SharePoint Server
• Business Portal site structure
• Choosing a site collection for Business Portal
• Installation checklist
• User rights for installation

Business Portal installation overview

Business Portal is a web-based application used to provide access to Microsoft 
Dynamics GP data to users who don’t have access to the Microsoft Dynamics GP 
application. You can use Business Portal as your company’s intranet by including 
other content that is used by your organization, but that is not stored in the 
accounting system, such as your company’s employee handbook.

Business Portal is built on a stack of other applications, beginning with Windows 
Server® 2003 or Windows Server 2008. Internet Information Services (IIS), a 
component of Windows Server 2003 or Windows Server 2008, hosts virtual servers, 
each of which can contain a separate web-based application. 

Business Portal is installed on a SharePoint web application and site collection. The 
main Business Portal site will be created as a subsite of the top-level site in the site 
collection. (For more information about the Business Portal site hierarchy, see 
Business Portal site structure on page 9.)

The following illustration shows the software configuration on a Business Portal 
web server. 

(For illustrations of Business Portal hardware configurations, including other 
servers, refer to Chapter 2, “Business Portal configurations.”)

Windows Server 2003
or

Windows Server 2008

SharePoint

Business
Portal

Internet Information Services (IIS)

virtual servervirtual server virtual server
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Domain users can access Business Portal through a web browser. By default, 
Business Portal is designed for intranet use; it is typically accessed over a local 
network or through a virtual private network (VPN). However, you can configure 
Business Portal to support external users. For more information, see Part 5, Extranet 
deployment.

Windows SharePoint Services vs. Office SharePoint 
Server

You can install Business Portal on Windows SharePoint Services or on Office 
SharePoint Server, Enterprise Edition.

Office SharePoint Server uses Windows SharePoint Services technology. Any 
features available in Windows SharePoint Services are also available in Office 
SharePoint Server. However, Office SharePoint Server offers additional features. For 
example, Office SharePoint Server uses the same search technology as Windows 
SharePoint Services but includes the ability to search for data in business 
applications such as Microsoft Dynamics GP.

If you install on Office SharePoint Server, Enterprise Edition, additional Business 
Portal and SharePoint features are available. The additional features include:

Search The Search feature integrates Web Services for Microsoft Dynamics GP 
with the Office SharePoint Server Business Data Catalog, which enables you to 
search for Microsoft Dynamics GP data along with content from your SharePoint 
sites.

List pages List pages use the Business Data Catalog integration with the 
Microsoft Dynamics GP web service to display information from Microsoft 
Dynamics GP.

Report Center The Office SharePoint Server, Enterprise Edition, version of 
Business Portal uses the Report Center site for publishing Microsoft Dynamics GP 
reports. The Report Center site provides the flexibility to publish other types of 
reports, such as FRx reports or reports from applications like Microsoft Office Excel. 
Using SharePoint features, users can receive alerts when new reports are added to 
the Report Center, create document workspaces to collaborate on reports, set up 
workflows to review reports, and even access reports offline.

Field Service Suite The Field Service Suite application is available only if 
you’re using Business Portal with Office SharePoint Server. Use this application to 
allow your customers to enter, view, and update service requests and return 
requests.

For more information about Search, list pages, and the Report Center, see the 
Business Portal Administrator’s Guide.
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Business Portal site structure

Business Portal is composed of multiple web sites. The top-level Business Portal site 
contains the main Home page and the administration pages for Business Portal and 
its applications. Each Business Portal center is a subsite that contains pages related 
to a particular department or role.

The following illustration shows the Business Portal site structure. (You may have 
additional center subsites in your implementation.)

Choosing a site collection for Business Portal

The Business Portal sites belong to a site collection—a hierarchical set of sites that can 
be managed together. You can install Business Portal into an existing site collection 
or into a new site collection. 

Sites within a site collection have common features, such as shared permissions, 
galleries for templates, content types, and web parts, and they often share a 
common navigation. All sites in a site collection are stored together in the same 
Microsoft SQL Server® database. The Business Portal sites interact with the site 
collection in the following ways.

Finance

Center site

Human 

Resources 

Center site

Purchasing 

Center site

Sales

Center site

Top-level 

Business 

Portal site

Top-level 

SharePoint 

site

Search

Center site 

(Office

SharePoint 

Server only)

Report 

Center site 

(Office

SharePoint 

Server only)
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Navigation Navigation inheritance depends on how Business Portal was 
implemented.

• If you’re using Business Portal with Windows SharePoint Services only, the 
Business Portal sites have their own navigation that is not inherited from the 
site collection, as shown in the following illustration.

• If you’re using Business Portal with Office SharePoint Server, Enterprise 
Edition, the Business Portal sites inherit navigation from the top-level site in the 
site collection. If you install into an existing site collection, a Business Portal 
item will be added to the top link bar, and Business Portal sites will use the 
existing navigation of the site collection, as shown in the following illustration.

For more information about Business Portal navigation, see the Business Portal 
Administrator’s Guide.

Permissions The Business Portal sites do not inherit permissions from the top-
level site in the site collection. Installing into an existing site collection will not affect 
Business Portal permissions. For more information about Business Portal 
permissions, see the Business Portal Administrator’s Guide.

Galleries Template galleries, content type galleries, and web part galleries are 
shared between Business Portal sites and other sites in the collection. Install into an 
existing site collection if you want to share gallery content between your existing 
sites and your Business Portal sites.

For more information about site collections, see the SharePoint documentation.
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Installation checklist

You must perform the following tasks to install Business Portal.

User rights for installation

The person installing Business Portal and its prerequisites must be logged on to the 
web server computer as a user with the following access rights.

Administrator rights on the server The person installing Business Portal 
must be a member of the Administrators group on the web server where Business 
Portal is being installed. The administrator user who installs Business Portal 
automatically becomes the first administrator of Business Portal.

Administrator rights for Windows SharePoint Services The person 
installing Business Portal must be the administrator of the site collection where 
Business Portal is being installed.

Task For more information, see

1. Check for new information relating 
to the installation since the release of 
this document.

Microsoft Dynamics GP documentation web site:
http://go.microsoft.com/fwlink/?LinkId=185513

2. View the Readme file and make note 
of the items that pertain to your 
Business Portal system.

\Media\Documentation\Readme.rtf

3. Be sure that you have the 
appropriate rights to perform the 
installation.

User rights for installation on page 11

4. Select a Business Portal 
configuration.

Chapter 2, “Business Portal configurations”

5. Be sure that your computers meet 
requirements.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkId=187656
Business Portal 5.0 is not supported on 64-bit versions 
of Windows and SharePoint. 

6. Be sure that your network meets 
requirements.

Chapter 3, “Network environment”

7. Configure the SQL server. Chapter 4, “SQL Server configuration”

8. Configure the web server. Chapter 5, “Web server configuration”

9. Install and configure Windows 
SharePoint Services or Office 
SharePoint Server on the web server.

Chapter 6, “Windows SharePoint Services 
configuration”
Chapter 7, “Office SharePoint Server configuration”

10. Install Business Portal on the web 
server.

Chapter 8, “Before you install”
Chapter 9, “Installing Business Portal”
Chapter 10, “Additional applications”

11. Configure workstations and 
perform optional tasks.

Chapter 12, “Reports Catalog setup” 
Chapter 13, “Terminal Services setup” 
Chapter 14, “Client configuration”

12. Set up Business Portal. Business Portal Administrator’s Guide

13. Set up any additional applications 
you’ve installed.

Administrator’s Guide for each application

http://go.microsoft.com/fwlink/?LinkId=185513
http://go.microsoft.com/fwlink/?LinkId=187656
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Administrator rights for SQL Server If you’re using Windows Trusted 
Authentication for the Business Portal installation, the person installing Business 
Portal must have Administrator rights to the SQL Server where Microsoft Dynamics 
GP information is stored.

User rights for Web Services for Microsoft Dynamics GP If you’re 
installing Business Portal on Office SharePoint Server, the person installing Business 
Portal must have access to the Microsoft Dynamics GP web service. If you’re not 
already in a web service role, we recommend using the BDC Administrator role.
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Chapter 2: Business Portal configurations
This chapter describes the server configurations that you can use for Business 
Portal. 

Business Portal configurations designated “intranet only” should be deployed only 
in your internal network; they should not be used in an extranet environment. An 
extranet, or perimeter network, is an extension of your company’s intranet that 
provides limited access to authorized outside users. For more information about 
deploying Business Portal in an extranet, refer to Chapter 15, “Extranet 
environments.” 

For up-to-date system requirements for the servers in these configurations, see 
http://go.microsoft.com/fwlink/?LinkID=187656.

This chapter includes the following sections:

• Business Portal and Microsoft Dynamics GP on the same server (intranet only)
• Business Portal and Microsoft Dynamics GP on separate servers
• Terminal Services configuration (intranet only)
• Multiple web servers configuration
• Multiple server farms configuration

Business Portal and Microsoft Dynamics GP on the 
same server (intranet only)

In a single server configuration, one computer functions as the SQL database server 
and the web server. It stores your Microsoft Dynamics GP information, and hosts 
your Business Portal web site.

If you use the Small Business Server operating system, your web server also may be 
a domain controller and may host other server applications, such as Microsoft 
Exchange. When choosing a server computer for this configuration, consider the 
processor and RAM requirements of all applications that will run on the server. 

We don’t recommend using this configuration in an extranet environment. For better 
security, your Microsoft Dynamics GP databases should be on a separate server, inside the 
firewall.

Business Portal and Microsoft Dynamics GP on 
separate servers

In a separate server configuration, the Microsoft Dynamics GP SQL database and 
Business Portal are installed on separate servers: your existing Microsoft Dynamics 
GP server and a web server. You also can add a Terminal Services server or 
additional web servers to the configuration. (These configurations are described in 
Terminal Services configuration (intranet only) on page 14 and Multiple web servers 
configuration on page 15.)

http://go.microsoft.com/fwlink/?LinkID=187656
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The following illustration shows a separate server configuration.

Terminal Services configuration (intranet only)

Some links in Business Portal are for tasks performed in Microsoft Dynamics GP. 
Business Portal can use Terminal Services, a component of the Windows operating 
system, to give users access to your Microsoft Dynamics GP software over the Web. 
This is commonly called “thin client” access.

If a user is set up to use thin client access and clicks a task link that opens a back 
office window, Business Portal connects to the Terminal Services server, and 
displays the Microsoft Dynamics GP user interface. All operating system 
functions—as well as the actual Microsoft Dynamics GP application—run on the 
Terminal Services server. Terminal Services is used only for access to Microsoft 
Dynamics GP windows; Microsoft Dynamics GP data displayed in Business Portal 
is not processed through the Terminal Services server.

We don’t recommend using this configuration in an extranet environment. For better 
security, you should not grant access to the Microsoft Dynamics GP application outside of 
the firewall without a virtual private network (VPN).

The following illustration shows a configuration that includes a Terminal Services 
server.

Business Portal 

(Web server)

Workstation

Workstation

Back office server

Back office server

Business Portal 

(Web server)

Terminal Services server

Workstation

Workstation

Query data

Back office 

screens
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You can include multiple Terminal Services servers in a Business Portal 
configuration for load balancing. 

For more information about setting up Business Portal to use Terminal Services, 
refer to Chapter 13, “Terminal Services setup.”

Multiple web servers configuration

If there will be a lot of traffic on the Business Portal web site, you might want to add 
web servers to your configuration to improve performance. For more information 
about using multiple web servers for load balancing, refer to the Business Portal 
Administrator’s Guide. You might also have separate web servers for Business 
Portal and Web Services for Microsoft Dynamics GP.

The following illustration shows a server farm—that is, a configuration that 
includes multiple web servers.

In an extranet environment, you can deploy multiple Business Portal web servers in 
your intranet and multiple web servers in your extranet. 

If you want to deploy separate internal and external Business Portal sites, use 
multiple server farms. For more information, see Multiple server farms configuration 
on page 16.

Back office server

Business Portal 

(Web server)

Workstations

Business Portal 

(Web server)
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Multiple server farms configuration

If Business Portal will be deployed in an extranet, and you want to segregate 
functionality for external users, you can deploy separate server farms for internal 
and external users. (In SharePoint, a server farm can consist of a single web server.)

For example, if you use Office SharePoint Server Search functionality for Microsoft 
Dynamics GP data, and you deploy Business Portal for users outside of your 
company, you may want to set up separate server farms to help secure Search data. 
On the external server farm you could install only those applications used by 
external users, and you could choose not to enable Search for Microsoft Dynamics 
GP data. On the internal server farm you could install the applications used by your 
internal users, including Search. 

For more information about securing Search data, refer to the Business Portal 
Administrator’s Guide.

Each Office SharePoint Server farm has its own configuration and content 
databases, which means that SharePoint features such as navigation, security 
through SharePoint groups, and Search are separate. However, all Business Portal 
installations must share a single Microsoft Dynamics GP SQL database. This means 
that data security through Microsoft Business Framework roles and permissions is 
shared.

The following illustration shows a configuration with multiple server farms.

Internet

Internal Business 

Portal server farm

External Business 

Portal server farm

`

Internal client 

workstations

Internal 

SharePoint 

databases

Database server

External 

SharePoint 

databases

Back office 

databases
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Part 2: Network and server 
configuration
This part of the documentation explains how to prepare your network and servers 
for Business Portal.

The following information is discussed:

• Chapter 3, “Network environment,” lists the network requirements for Business 
Portal.

• Chapter 4, “SQL Server configuration,” explains SQL Server concepts related to 
Business Portal.

• Chapter 5, “Web server configuration,” describes how to set up a web server for 
Business Portal.

• Chapter 6, “Windows SharePoint Services configuration,” explains installation 
considerations if you’re installing Business Portal on Windows SharePoint 
Services. This chapter also contains procedures for installing and configuring 
Windows SharePoint Services.

• Chapter 7, “Office SharePoint Server configuration,” explains installation 
considerations if you’re installing Business Portal on Office SharePoint Server. 
This chapter also contains procedures for installing and configuring Office 
SharePoint Server.
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Chapter 3: Network environment
This chapter contains information about the network configuration that must be in 
place before installing Business Portal.

For additional network information relating to Windows SharePoint Services or 
Office SharePoint Server, refer to your SharePoint documentation.

The following sections are included:

• Network environment requirements
• Protocol
• Domain

Network environment requirements

To get the best possible performance from Business Portal, be sure that your 
network meets the following requirements.

Protocol

TCP/IP must be running on your network. For more information about TCP/IP, 
refer to your Windows documentation.

IP addresses
Each computer that you use must have a unique IP address (Internet Protocol 
address) associated with it. For more information about IP addresses, refer to your 
networking protocol software documentation.

TCP/IP name resolution
You should use some type of name resolution in your network, so that each 
computer is identified by a unique hostname. Name resolution is a method of 
identifying each computer, and can be accomplished by having a specific server act 
as a domain name server, or putting a hosts file on each client and server.

For more information about name resolution using either a domain name server or 
hosts files, refer to your networking protocol software documentation.

Domain

To use Business Portal, your web server, back office server, Terminal Services server 
(if applicable), and client workstations must belong to a domain. In addition, all 
Business Portal users—both internal and external—must have valid Windows 
domain accounts.

A domain is a group of computers that are part of a network and share a common 
directory database. A domain is administered as a unit with common rules and 
procedures. Each domain has a unique name. 

Minimum Recommended

Server-to-server 100 Mbps Ethernet 100 Mbps Ethernet

Server-to-client 10 Mbps Ethernet 100 Mbps Ethernet

Remote users (VPN or extranet) Broadband: cable or DSL Broadband: cable or DSL
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If you’re deploying Business Portal in an extranet, the perimeter network may 
belong to the internal domain, or you may set up two domains—one for the internal 
network and one for the perimeter network. If you have two domains, a trust may 
be set up between them. For more information about extranet configurations, refer 
to Chapter 15, “Extranet environments.”

For information about setting up and administering a domain, refer to your 
Windows documentation.
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Chapter 4: SQL Server configuration
This chapter describes SQL Server concepts you should understand before 
installing Business Portal on your web server.

The following sections are included:

• SQL Server sort order and Windows SharePoint Services or Office SharePoint Server
• SharePoint databases
• SQL Server authentication methods
• Configuring SQL Server to use mixed-mode authentication
• SQL Server logon IDs
• SQL Server communication

SQL Server sort order and Windows SharePoint 
Services or Office SharePoint Server

Windows SharePoint Services and Office SharePoint Server use SQL Server or SQL 
Server Express databases to store information, depending on which installation 
type you choose.

SQL Server If you choose the Advanced installation for Windows SharePoint 
Services or Office SharePoint Server, the SharePoint databases will be installed on a 
SQL Server that you select. 

The SharePoint content database can’t be installed on a SQL Server that uses binary 
sort order. If your existing SQL Server uses binary sort order, you can create a new 
instance of SQL Server with sort order 52 (Dictionary Order, Case Insensitive) and 
install the SharePoint content database on the new instance. For more information 
about SQL Server instances and sort orders, refer to SQL Server Books Online.

Creating a new instance may require additional SQL Server licensing. Refer to your license 
agreement for more information.

SQL Server Express If you choose the Basic installation for Windows 
SharePoint Services or Office SharePoint Server, SQL Server Express will be 
installed on the web server for the SharePoint databases. SQL Server Express will be 
set up to use a dictionary order, case insensitive sort order. Your back office SQL 
Server sort order doesn’t matter in this case.

For more information about SharePoint installation types, refer to Windows 
SharePoint Services installation considerations on page 29. 

SharePoint databases

Windows SharePoint Services and Office SharePoint Server rely on databases to 
store all data for a web application, including both configuration settings and site 
content.

Configuration database The configuration database maintains connections 
between servers and content databases, stores server settings, and identifies which 
content is to be provided by which web application. There is one configuration 
database per stand-alone server or per server farm.
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Content database When you create a web application, you choose whether to 
create a new content database or connect to an existing content database. Content 
databases store data from the sites: both site management data, such as user names 
and permissions, and content, such as list data and documents from document 
libraries.

You can create as many content databases as you need to support the web sites on 
your servers. For a departmental server, you may need only one content database. 
For a server farm, you may need thousands. For a web site that is available to 
members both inside and outside of a firewall (an extranet), you may have one 
content database linked to two web applications with different URLs.

For more information about the configuration and content databases, refer to your 
SharePoint documentation.

SQL Server authentication methods

During the Business Portal installation, you’ll need to specify the authentication 
method you want to use when connecting to the Microsoft Dynamics GP SQL 
Server.

To be able to use multiple authentication methods, the SQL Server must use mixed-
mode authentication. For more information, refer to Configuring SQL Server to use 
mixed-mode authentication on page 22.

There are two authentication methods:

Windows Trusted Authentication If you’re using Windows Trusted 
Authentication, be sure that the user who’s logged on to the computer where you’re 
installing Business Portal has administrator rights for the Microsoft Dynamics GP 
SQL Server, either as a SQL user or as part of the Local Admin group on the SQL 
server.

When connecting to SQL Server using the Windows Trusted Authentication 
method, you won’t have to enter a SQL Server-specific logon ID and password. 
Instead, SQL Server identifies you by the Windows user ID you entered when 
logging on to the network. SQL Server then permits or denies logon access based on 
that user ID.

SQL Authentication When connecting to SQL Server using the SQL 
Authentication method, you must enter a SQL Server-specific logon ID and 
password. SQL Server verifies that the logon ID exists, and then permits access.

For more information about when these methods are used, refer to SQL Server logon 
IDs on page 23.

Configuring SQL Server to use mixed-mode 
authentication

The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-
mode authentication. (Mixed-mode authentication allows you to use either 
Windows Authentication or SQL Authentication to access the SQL Server.) Use the 
following procedure to set up mixed-mode authentication.
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To configure SQL Server 2005 to use mixed-mode 
authentication:
1. Open SQL Server Management Studio.

Start > All Programs > Microsoft SQL Server 2005 > SQL Server Management 
Studio

2. Right-click the SQL server with your Microsoft Dynamics GP databases, and 
click Properties.

3. The Server Properties window appears. Select the Security page.

4. Select the SQL Server and Windows Authentication mode option.

5. Click OK, then close SQL Server Management Studio.

To configure SQL Server 2008 to use mixed-mode 
authentication:
1. Open SQL Server Management Studio.

Start > All Programs > Microsoft SQL Server 2008 > SQL Server Management 
Studio

2. Right-click the SQL server with your Microsoft Dynamics GP databases, and 
click Properties.

3. The Server Properties window appears. Select the Security page.

4. Select the SQL Server and Windows Authentication mode option.

5. Click OK, then close SQL Server Management Studio.

SQL Server logon IDs

During the Business Portal installation, you’ll need to enter the following SQL 
Server logon IDs:

• The SQL Server administrator logon ID—entered in the Connection 
Information window if you choose to use SQL authentication—can be any SQL 
logon ID that has administrator privileges with access to all Microsoft 
Dynamics GP SQL databases. You can use the sa logon, but are not required to 
do so.

These credentials are used only during the Business Portal installation process, 
to permit the installation wizard to create the Business Portal logon ID. The SQL 
Server administrator credentials are not used again.

• The Business Portal logon ID—entered in the Business Portal SQL 
Configuration window—is the logon account Business Portal uses to access 
data in SQL Server. This logon ID is used continually to access Microsoft 
Dynamics GP data.
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The default entry in the Business Portal SQL Configuration window is 
BusinessPortalUser. However, you can also use an existing SQL user or create 
your own SQL user. If you enter a nonexistent SQL logon in the window, that 
user will be created automatically in SQL Server during the Business Portal 
installation.

If you’re installing Business Portal on multiple web servers, be sure that the 
same Business Portal logon ID and password are used for all web servers.

SQL Server communication

The SQL Server must be set up to use the TCP/IP network protocol. Using the 
Named Pipes protocol can cause intermittent errors in Business Portal. For 
information about setting up SQL Server to use TCP/IP, refer to SQL Server Books 
Online.
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Chapter 5: Web server configuration
This chapter contains information about procedures you should perform on the 
web server before installing Business Portal. 

This information is divided into the following sections:

• System requirements
• Install Internet Information Services (IIS)
• Application Server role
• Configure Secure Sockets Layer (SSL)
• Turn off unnecessary privileges
• Using Network Load Balancing with Business Portal

System requirements

For up-to-date system requirements for the web servers where you will install 
Business Portal, see http://go.microsoft.com/fwlink/?LinkID=187656.

Install Internet Information Services (IIS)

Internet Information Services (IIS) should be installed before you install any other 
prerequisites on the web server.

For file system-level security, install the IIS web root on a non-system NTFS 
partition. A non-system partition is one other than the partition containing the 
operating system files (for example, C:\Winnt). For more information about 
security best practices for IIS, refer to the IIS Operations Guide, available on 
Microsoft TechNet (technet.microsoft.com).

Windows Server 2003
1. Choose Add or Remove Programs from the Windows Control Panel.

2. Click Add/Remove Windows Components. The Windows Components 
Wizard window is displayed.

3. Select Application Server and then click Details. The Application Server 
window is displayed.

4. Select ASP.NET, Enable network COM+ access, and Internet Information 
Services (IIS).

To make your web servers as secure as possible, we recommend that you use 
only these services, which are required to run Business Portal.

Click OK.

5. Click Next in the Windows Components Wizard window. When the installation 
process is complete, click Finish.

6. After you install IIS, open IIS Manager (Start > Administrative Tools > IIS 
Manager) and click the Web Service Extensions node. Verify that Microsoft 
FrontPage® 2002 Server Extensions are prohibited for the web site where you 
will install Business Portal.

http://technet.microsoft.com
http://go.microsoft.com/fwlink/?LinkID=187656
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Windows Server 2008
1. Open the Server Manager.

Start > Administrative Tools > Server Manager.

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. Click Next to 
continue.

5. Review the information about the Web Server (IIS) role. Click Next to continue.

6. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

7. In the Select Role Services window, select the following components for the 
Management Tools role service.

• IIS Management Console
• IIS 6 Management Compatibility

8. Click Next.

9. Review the installation messages, and then click Install.

10. After you have viewed the installation results, click Close.

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors

Application Development ASP.NET
NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side Includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authentication
Windows Authentication
Digest Authentication
Request Filtering

Performance Static Content Compression
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Application Server role

When running Business Portal on Windows Server 2008, the Application Server role 
is required. To install this role, complete the following steps.

1. Open the Server Manager.
Start > Administrative Tools > Server Manager.

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select Application Server. Click Next to continue.

5. Review the information about the Application Server role. Click Next to 
continue.

6. In the Select Role Services window, select the following components for the 
Management Tools role service.

• COM+ Network Access
• Distributed Transactions
• Incoming Remote Transactions
• Outgoing Remote Transactions

7. Click Next in the Select Role Services window.

8. Review the installation messages, and then click Install.

9. After you have viewed the installation results, click Close.

Configure Secure Sockets Layer (SSL)

Secure Sockets Layer (SSL) is recommended, but not required, for the Business 
Portal web site. SSL is a protocol that allows web servers and clients to 
communicate more securely through the use of encryption. When SSL is not used, 
data sent between the client and server is vulnerable to anyone with physical access 
to the network.

To help protect your data, you must use Secure Sockets Layer (SSL) for your Business Portal 
web site if it is deployed in an extranet. For more information about extranet deployment, 
refer to Chapter 15, “Extranet environments.”

To enable authentication through SSL, you must install a certificate and a private 
key on your web server. For more information about configuring SSL, refer to the 
IIS Operations Guide, available on Microsoft TechNet (technet.microsoft.com).

We recommend configuring SSL before installing Windows SharePoint Services or 
Office SharePoint Server and Business Portal. If you implement SSL after Business 
Portal has been installed, you must make the SSL changes described in the 
“Configuration Changes” chapter of the Business Portal Administrator’s Guide.

http://technet.microsoft.com
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Turn off unnecessary privileges

For better security, you should turn off unnecessary server computer and server site 
privileges on the web server. For information about securing a Windows Server 
2003 computer or Windows Server 2008 computer, refer to the Windows Server 2003 
Security Guide or the Windows Server 2008 Security Guide, available as a 
download on the Microsoft TechNet Security Center (www.microsoft.com/technet/
security). 

Using Network Load Balancing with Business Portal

Business Portal uses a session state setting of InProc, which means that client 
sessions are managed by and stored on the web server. (A session is a series of 
requests issued by the same client within a certain period of time.) The InProc 
session state setting does not allow session state to be stored across servers in a web 
farm.

If you’re using Network Load Balancing in a web farm, you should set single 
affinity for the Business Portal application. Affinity is the method used to associate 
client requests to servers. When no affinity is specified, requests are distributed 
across the load-balanced cluster without respect to their source. Single affinity 
always returns each client’s traffic to the same server. Directing TCP connections 
from the IP address to the same server allows Business Portal to maintain session 
state information in the server memory.

For more information about setting up affinity, see the Network Load Balancing 
documentation in the Windows Server 2003 Technical Reference on Microsoft 
TechNet (technet.microsoft.com).

For more information about setting up affinity, see the Network Load Balancing in 
Windows Server 2008 documentation on Microsoft TechNet 
(technet.microsoft.com).

http://www.microsoft.com/technet/security
http://www.microsoft.com/technet/security
http://technet.microsoft.com
http://technet.microsoft.com
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Chapter 6: Windows SharePoint Services 
configuration
This chapter explains how to install and configure Windows SharePoint Services for 
use with Business Portal. You must install Windows SharePoint Services or Office 
SharePoint Server on the web server before installing Business Portal.

If you’re installing Business Portal with Office SharePoint Server, skip this chapter 
and refer to Chapter 7, “Office SharePoint Server configuration.”

This chapter doesn’t provide comprehensive information about Windows SharePoint 
Services. For complete information about Windows SharePoint Services concepts and setup 
procedures, see the Windows SharePoint Services documentation.

This chapter contains the following sections:

• Windows SharePoint Services installation considerations
• User accounts for Windows SharePoint Services
• Install Windows SharePoint Services
• Create a web application and site collection using Windows SharePoint Services
• Configure a Service Principal Name

Windows SharePoint Services installation 
considerations

Before installing Windows SharePoint Services, you must determine which type of 
SharePoint installation to perform: Basic or Advanced. We recommend choosing the 
Advanced option.

Basic
If you choose the Basic option, the following conditions apply.

• Business Portal can be installed on only a single web server. Additional 
configuration would be necessary to spread the processing load over multiple 
servers in a server farm.

• The SharePoint databases will be created in a new instance of SQL Server 2005 
Express. You will not have the option of using an existing SQL Server instance 
to store the SharePoint databases.

• A web application and site collection are created on the default web site. This 
may cause a conflict if you already have content for the default web site.

• The application pool created for the SharePoint site will be run using the 
Network Service identity. If you install Business Portal on that site, many of its 
actions will be performed by the Network Service user. Some Business Portal 
applications such as Benefit Self Service  require access to the Web Services for 
Microsoft Dynamics GP. However, Web Services for Microsoft Dynamics GP  
cannot be accessed by the Network Service user. This means you will need to 
change the application pool identity for the Business Portal site to be a standard 
machine user or domain user.

Choosing the Advanced installation option allows you to make these configuration 
decisions before you install Business Portal.
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Advanced
If you choose the Advanced option, the following conditions apply.

• Business Portal can be installed on more than one web server. 

• This option also allows you to install the SharePoint databases on an existing 
SQL Server instead of on a new instance of SQL Server 2005 Express on the web 
server. The Windows SharePoint Services configuration and content databases 
will be created on the SQL Server you specify. 

If your existing SQL Server is near capacity, we recommend installing the SharePoint 
configuration and content databases on a different SQL server. Installing SQL Server 
on an additional computer may require additional SQL Server licensing. Refer to your 
license agreement for more information.

• A web application and site collection must be created manually within 
SharePoint Central Administration. For more information, refer to Create a web 
application and site collection using Windows SharePoint Services on page 31. 

User accounts for Windows SharePoint Services

If you’re going to install the advanced version of Windows SharePoint Services, you 
must first create user accounts that SharePoint can use to launch services, run 
processes, and connect to the SQL server.

You don’t need to create these accounts if you’re going to use the basic installation method 
for Windows SharePoint Services.

You’ll need to create the following user accounts for Windows SharePoint Services. 
For more information about administrative and service accounts for Windows 
SharePoint Services, refer to the Windows SharePoint Services 3.0 Technical Library 
on Microsoft TechNet (technet.microsoft.com).

• A domain user account that acts as the application pool identity for the web 
application where you will create the Business Portal site collection.

We recommend creating an account called wss_user. This user account must be 
member of the IIS Worker Process (IIS_WPG) group on the web server, and the 
account must be dedicated (used only by SharePoint).

If you’re installing on multiple web servers, the account must be a Business 
Portal user.

For more information, see Create a web application and site collection using 
Windows SharePoint Services on page 31.

• A domain user account under which the Windows SharePoint Services Search 
service can run. The user account must be a member of the Administrators 
group on the computer that is running the Search service.

• A domain user account that acts as the identity for the SharePoint Central 
Administration application pool. The Windows SharePoint Services Timer 
service also runs under this account. 

http://technet.microsoft.com
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Install Windows SharePoint Services

You can download Windows SharePoint Services 3.0 from the Microsoft Download 
Center (www.microsoft.com/downloads). Refer to the Windows SharePoint 
Services 3.0 Technical Library on Microsoft TechNet (technet.microsoft.com) for 
information about installing.

After installing Windows SharePoint Services, you may be instructed to restart your 
computer.

Be sure to use the SharePoint Products and Technologies Configuration wizard 
(Start > All Programs >Administrative Tools > SharePoint Products and 
Technologies Configuration wizard) to configure Windows SharePoint Services. 
The SharePoint Products and Technologies Configuration Wizard automates several 
configuration tasks, including installing and configuring the configuration 
database, installing Windows SharePoint Services 3.0 services, and creating the 
Central Administration web site.

When you’re configuring Windows SharePoint Services within the SharePoint 
Central Administration web site, you can choose either Kerberos authentication or 
NTLM authentication. Unless you have a specific need for Kerberos authentication, 
you should choose NTLM authentication. For more information about running 
Windows SharePoint Services using Kerberos authentication, refer to Microsoft 
Knowledge Base Article 832769. (Go to support.microsoft.com and type 832769 in 
the Search box.)

If you use Kerberos authentication and the application pool identity is a domain 
account, your domain administrator must configure a Service Principal Name 
(SPN) for that account. For more information, see Configure a Service Principal Name 
on page 33.

Create a web application and site collection using 
Windows SharePoint Services

If you have installed Windows SharePoint Services using the Advanced option, a 
web application and site collection must be created on the virtual server where you 
want to install Business Portal. The Business Portal installation program can create a 
web application and site collection for you. You can also create a web application 
and site collection manually using the procedures in this section.

You don’t need to create a web application and site collection as separate steps if you’re using 
the basic installation method for Windows SharePoint Services. The basic installation 
method creates a web application and site collection automatically on the default virtual 
server.

For more information about web applications and site collections, refer to the 
Windows SharePoint Services 3.0 Technical Library on Microsoft TechNet 
(technet.microsoft.com).

To create a web application:
1. Open SharePoint Central Administration. 

Start > Administrative Tools > SharePoint Central Administration

2. Click Application Management.

http://www.microsoft.com/downloads
http://support.microsoft.com
http://technet.microsoft.com
http://technet.microsoft.com
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3. Under the SharePoint Web Application Management heading, click Create or 
extend Web application.

4. Click Create a new Web application. 

5. Select an IIS web site and security configuration.

6. In the Application Pool section, click Create a new application pool and enter 
a name (we recommend calling the new application pool BusinessPortal).

When a web application fails, it usually causes the application pool to fail, as well. If you 
are going to install other web applications on this server, we recommend that you assign 
them to separate application pools. That way, one failed application can’t cause the other 
applications to fail.

7. Click Configurable and enter the user account you created for SharePoint. (For 
more information about the user account, refer to User accounts for Windows 
SharePoint Services on page 30.) Be sure to enter the account in 
domain\username format.

8. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

We recommend that the database name should be the <Web Application name> - Port#. 
An example of a database name is MySites - 82

9. On the Application Created page, click Create Site Collection. 

To create a site collection:
1. If you’re not already on the Create Site Collection page, go to SharePoint 

Central Administration and click Application Management. Under the 
SharePoint Site Management heading, click Create site collection.

2. Select the web application you just created.

3. Enter a title and description for the site collection. 

You cannot install Business Portal if the name of the site collection contains “BP” or 
“Business Portal” in its name.

4. Specify the URL for the site collection, if necessary.

Be sure the URL does not contain spaces.

5. Select the Team Site template.

6. Specify a site collection administrator.

7. Click OK.
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Configure a Service Principal Name

If the Business Portal web application was configured to use Kerberos 
authentication and the application pool identity is a domain account, your domain 
administrator must configure a Service Principal Name (SPN) for that account. 
Service principal names are unique identifiers for services running on servers. 
Every service that uses Kerberos authentication must have an SPN so that clients 
can identify the service on the network.

If the application pool identity for the SharePoint site is configured to use a built-in account 
such as Network Service, you do not have to set up an SPN. The built-in accounts are 
automatically configured to work with Kerberos authentication.

Use the Setspn.exe command-line tool to configure an SPN. You can get the tool by 
downloading Support Tools for Windows Server 2003 from the Microsoft Download 
Center (www.microsoft.com/downloads). The Setspn.exe command-line tool is 
available in Windows Server 2008 if you have installed the Active Directory Domain 
Services server role using Server Manager. You must run the Setspn.exe command 
with the appropriate user privilege. Click Start, right-click Command Prompt, and 
then click Run as administrator. 

For information about using the Setspn.exe tool, refer to the Windows Server 2003 
Technical Reference on Microsoft TechNet (technet.microsoft.com).

http://www.microsoft.com/downloads
http://technet.microsoft.com
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Chapter 7: Office SharePoint Server 
configuration
This chapter explains how to install and configure Office SharePoint Server for use 
with Business Portal. You must install Windows SharePoint Services or Office 
SharePoint Server on the web server before installing Business Portal.

If you’re installing Business Portal with Windows SharePoint Services only, skip this 
chapter and refer to Chapter 6, “Windows SharePoint Services configuration.”

This chapter doesn’t provide comprehensive information about Office SharePoint Server. For 
complete information about Office SharePoint Server concepts and setup procedures, see the 
Office SharePoint Server documentation.

This information is divided into the following sections:

• Office SharePoint Server installation considerations
• User accounts for Office SharePoint Server
• Install Office SharePoint Server
• Start services in Office SharePoint Server
• Create a web application and site collection using Office SharePoint Server
• Create a shared service provider
• Configure a Service Principal Name

Office SharePoint Server installation considerations

Before installing Office SharePoint Server, you must determine which type of 
SharePoint installation to perform: Basic or Advanced. We recommend choosing the 
Advanced option.

Basic
If you choose the Basic option, the following conditions apply:

• Business Portal can be installed on only a single web server. Additional 
configuration would be necessary to spread the processing load over multiple 
servers in a server farm.

• The SharePoint databases will be created in a new instance of SQL Server 2005 
Express. You will not have the option of using an existing SQL Server instance 
to store the SharePoint databases.

• A web application and site collection are created on the default web site. This 
may cause a conflict if you already have content for the default web site.

• The application pool created for the SharePoint site will be run using the 
Network Service identity. If you install Business Portal on that site, many of its 
actions will be performed by the Network Service user. Some Business Portal 
applications such as Benefit Self Service  require access to the Web Services for 
Microsoft Dynamics GP. However, Web Services for Microsoft Dynamics GP  
cannot be accessed by the Network Service user. This means you will need to 
change the application pool identity for the Business Portal site to be a standard 
machine user or domain user.
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Choosing the Advanced installation option allows you to make these configuration 
decisions before you install Business Portal.

Advanced
If you choose the Advanced option, the following conditions apply.

• Business Portal can be installed on more than one web server. 

• This option allows you to install the SharePoint databases on an existing SQL 
Server instead of on a new instance of SQL Server 2005 Express on the web 
server. The Office SharePoint Server configuration and content databases will 
be created on the SQL Server you specify. 

If your existing SQL Server is near capacity, we recommend installing the SharePoint 
configuration and content databases on a different SQL server. Installing SQL Server 
on an additional computer may require additional SQL Server licensing. Refer to your 
license agreement for more information.

• A web application and site collection must be created manually within 
SharePoint Central Administration. For more information, refer to Create a web 
application and site collection using Office SharePoint Server on page 38. 

User accounts for Office SharePoint Server

If you’re going to install the advanced version of Office SharePoint Server, you must 
first create domain user accounts that SharePoint can use to launch services, run 
processes, and connect to the SQL server. 

You don’t need to create these accounts if you’re going to use the basic installation method 
for Office SharePoint Server.

You will need to create the following user accounts for Office SharePoint Server. For 
more information about administrative and service accounts for Office SharePoint 
Server, refer to the Office SharePoint Server Technical Library on Microsoft TechNet 
(technet.microsoft.com).

Domain user 
account

Description For more information

User account 1 A domain user account that acts as the application pool identity for the 
web application where you will create the Business Portal site 
collection.
We recommend creating an account called oss_user. This user account 
must be member of the IIS Worker Process (IIS_WPG) group on the 
web server, and the account must be dedicated (used only by 
SharePoint).

Create a web application and site 
collection using Office SharePoint 
Server on page 38

User account 2 A domain user account under which the Office SharePoint Server 
Search service can run. The user account must be a member of the 
Administrators group on the computer that is running the Search 
service.

User account 3 A domain user account that is used to crawl content on your sites and 
create indexes.

User account 4 A domain user account that acts as the identity for the SharePoint 
Central Administration application pool. The Windows SharePoint 
Services Timer service also runs under this account. 

User account 5 A domain user account that acts as the application pool identity for the 
web application where you will create the Shared Services Provider 
(SSP). 

 Create a shared service provider on 
page 39.

http://technet.microsoft.com
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Install Office SharePoint Server

Refer to the documentation included on your Office SharePoint Server DVD for 
information about installing.

Be sure to use the SharePoint Products and Technologies Configuration wizard 
(Start > All Programs >Administrative Tools > SharePoint Products and 
Technologies Configuiration wizard) to configure Windows SharePoint Services. 
The SharePoint Products and Technologies Configuration Wizard automates several 
configuration tasks, including installing and configuring the configuration 
database, installing Office SharePoint Services 3.0 services, and creating the Central 
Administration Web site.

When you’re configuring Office SharePoint Server withinthe SharePoint Central 
Administration web site, you can choose either Kerberos authentication or NTLM 
authentication. Unless you have a specific need for Kerberos authentication, you 
should choose NTLM authentication. For more information about running 
Windows SharePoint Services using Kerberos authentication, refer to Microsoft 
Knowledge Base Article 832769. (Go to support.microsoft.com and type 832769 in 
the Search box.)

If you use Kerberos authentication and the application pool identity is a domain 
account, your domain administrator must configure a Service Principal Name 
(SPN) for that account. For more information, see Configure a Service Principal Name 
on page 40.

Start services in Office SharePoint Server

After you have installed and configured Office SharePoint Server on all of your 
front-end servers, you must configure Office SharePoint Server services. The 
services you need to configure depend on your server topology and the server roles 
you deploy. For Business Portal, you must start the Windows SharePoint Services 
Web Application, Office SharePoint Server Search services, and Excel Calculation 
Services, at minimum.

Use the following procedure to start services. For more information about services, 
see the Office SharePoint Server documentation.

1. Open SharePoint Central Administration.
Start > Administrative Tools > SharePoint Central Administration

2. Click Operations.

3. Under Topology and Services, click Services on server.

4. Start the required services for your configuration.

User account 6 A domain user account under which the SSP runs. Create a shared service provider on 
page 39.

Domain user 
account

Description For more information

http://support.microsoft.com
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Create a web application and site collection using 
Office SharePoint Server

We recommend that you install Office SharePoint Server using the Advanced 
option. When you install using the Advanced option, you must create web 
applications for Business Portal, MySites, and the Shared Service Provider 
manually. You also must create a site collection for Business Portal. 

Use the procedures in this section to create a web application and site collection 
manually within SharePoint Central Administration.

You don’t need to create a web application and site collection as separate steps if you’re using 
the basic installation method for Office SharePoint Server. The basic installation method 
creates a web application and site collection automatically on the default virtual server.

For more information, refer to the Office SharePoint Server documentation.

To create a web application:
1. Open SharePoint Central Administration. 

Start > Administrative Tools > SharePoint Central Administration

2. Click Application Management.

3. Under the SharePoint Web Application Management heading, click Create or 
extend Web application.

4. Click Create a new Web application. 

5. Select an IIS web site and security configuration.

If Microsoft Dynamics GP Workflow has been installed on this web server, do not select 
the web site where Workflow was installed. Business Portal and Workflow can’t use the 
same web site.

6. In the Application Pool section, click Create a new application pool and enter 
a name (we recommend calling the new application pool BusinessPortal).

When a web application fails, it usually causes the application pool to fail, as well. If you 
are going to install other web applications on this server, we recommend that you assign 
them to separate application pools. That way, one failed application can’t cause the other 
applications to fail.

7. Click Configurable and enter the user account you created for SharePoint. (For 
more information about the user account, refer to User accounts for Office 
SharePoint Server on page 36.) Be sure to enter the account in domain\username 
format.

8. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

We recommend that the database name should be <Web Application name> - Port#. An 
example of a database name is MySites - 82.

9. On the Application Created page, click Create Site Collection. 
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To create a site collection:
1. If you’re not already on the Create Site Collection page, go to SharePoint 

Central Administration and click Application Management. Under the 
SharePoint Site Management heading, click Create site collection.

2. Select the web application you just created.

3. Enter a title and description for the site collection.

You cannot install Business Portal if the name of the site collection contains “BP” or 
“Business Portal” in its name.

4. Specify the URL for the site collection, if necessary.

Be sure the URL does not contain spaces.

5. On the Publishing tab, select the Collaboration Portal site template.

Only the Collaboration Portal template supports the configuration requirements for 
Business Portal. Other templates do not include the necessary Document Center, News, 
Reports, Search, and Sites tabs. If you select the wrong site template, you cannot change 
it without reinstalling Business Portal and Office SharePoint Server.

6. Specify a site collection administrator.

7. Click OK.

Create a shared service provider

A shared service provider (SSP) is used by an Office SharePoint Server farm to share 
resources for shared services, such as the Business Data Catalog. SSPs provide the 
databases, web services, and administration pages for shared services. For more 
information about shared service providers, see the Office SharePoint Server 
documentation.

1. Open SharePoint Central Administration.
Start > Administrative Tools > SharePoint Central Administration

2. Click Shared Services Administration.

3. On the Manage This Farm’s Shared Services page, click New SSP.

4. In the SSP Name section, in the SSP Name box, type a name for the new 
Service Principal Name (SSP).

5. On the Web Application menu, click a web application that will host an 
administration site for the new Shared Services Provider (SSP).

If you want to create a new web application to host the administration site for 
the new SSP, click Create a new web application.

The SSP Administration Site URL box is automatically populated with the 
administration URL.
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6. In the My Site Location section, on the Web Application menu, click a web 
application to host My Sites.

If you want to create a new Web application to host My Sites for the new SSP, 
click Create a new web application.

We recommend that you use different web applications to host My Sites and the SSP 
administration site so that you can independently back up and restore My Sites.

7. In the My Site Location URL box, type the URL for My Sites.

If you want to host My Sites at a location other than the root, change the relative 
URL in the Relative URL box.

8. In the SSP Service Credentials section, enter the user name and password that 
will be used by SSP web services for communications and by the SSP timer 
service for running jobs.

9. In the SSP Database section, in the Database Server box, type the name of the 
database server. In the Database Name box, type the name of the database.

Using the default database is recommended in most cases.

10. Under Database Authentication, select Windows authentication or SQL 
authentication.

11. In the Search Database section, in the Database Server box, type the name of 
the database server. In the Database Name box, type the name of the search 
database.

Using the default database is recommended in most cases.

12. Under Database Authentication, select Windows authentication or SQL 
authentication.

13. In the Index Server section, click an index server on the Index Server menu.

14. In the Path for index file location box, type the path of the index server where 
the indexes will be located.

15. If you want to use Secure Sockets Layer (SSL) to protect communications to and 
from web services, select Yes in the SSL for Web Services section.

16. Click OK.

Configure a Service Principal Name

If the Business Portal web application was configured to use Kerberos 
authentication and the application pool identity is a domain account, your domain 
administrator must configure a Service Principal Name (SPN) for that account. 
Service principal names are unique identifiers for services running on servers. 
Every service that uses Kerberos authentication must have an SPN so that clients 
can identify the service on the network.



I N S T A L L A T I O N G U I D E 41

C H A P T E R  7    O F F I C E  S H A R E P O I N T  S E R V E R  C O N F I G U R A T I O N

If the application pool identity for the SharePoint site is configured to use a built-in account 
such as Network Service, you do not have to set up an SPN. The built-in accounts are 
automatically configured to work with Kerberos authentication.

Use the Setspn.exe command-line tool to configure an SPN. You can get the tool by 
downloading Support Tools for Windows Server 2003 from the Microsoft Download 
Center (www.microsoft.com/downloads). The Setspn.exe command-line tool is 
available in Windows Server 2008 if you have installed the Active Directory Domain 
Services server role using Server Manager. You must run the Setspn.exe command 
with the appropriate user privilege. Click Start, right-click Command Prompt, and 
then click Run as administrator. 

For information about using the Setspn.exe tool, refer to the Windows Server 2003 
Technical Reference on Microsoft TechNet (technet.microsoft.com).

http://www.microsoft.com/downloads
http://technet.microsoft.com
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Part 3: Business Portal installation
This part of the documentation contains the procedures you’ll need to follow to 
install Business Portal. This part also contains some initial setup information.

The following information is included:

• Chapter 8, “Before you install,” describes installation concepts you should 
understand and pre-installation procedures you should perform.

• Chapter 9, “Installing Business Portal,” provides step-by-step instructions for 
installing Business Portal on your web server. It also provides an overview of 
the components that are installed with Business Portal.

• Chapter 10, “Additional applications,” includes a list of additional features and 
applications you can install with Business Portal, and step-by-step instructions 
for installing them.

• Chapter 11, “Troubleshooting the installation,” contains steps you can take to 
resolve common problems.

For additional setup information, including information about setting up users, 
refer to the Business Portal Administrator’s Guide.
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Chapter 8: Before you install
This chapter contains information you should be aware of before starting the 
Business Portal installation wizard. 

This information is divided into the following sections:

• Start services on the web server
• Install Business Portal prerequisites
• Back up SharePoint databases
• Register Business Portal applications

Start services on the web server

Before installing, verify that the following services are started on the web server 
where you will install Business Portal:

• Distributed Transaction Coordinator
• IIS Admin Service
• World Wide Web Publishing Service

Install Business Portal prerequisites

You may need to install the following prerequisites, depending on the Business 
Portal configuration you plan to install.

Windows SharePoint Services or Office SharePoint Server Business 
Portal is based on Windows SharePoint Services. You must install and configure 
either Windows SharePoint Services or Office SharePoint Server on web servers 
before you install Business Portal.

Windows SharePoint Services can be downloaded from the Microsoft Download 
Center. For more information, refer to Chapter 6, “Windows SharePoint Services 
configuration.”

Office SharePoint Server must be purchased separately. For more information, refer 
to Chapter 7, “Office SharePoint Server configuration.”

Catalog Maintenance This component is required to use the Order 
Management application. Catalog Maintenance is used to create item catalogs for 
managing inventory items. You can install this component on any computer that 
has an ODBC connection to the Microsoft Dynamics GP server.

Catalog Maintenance can be installed using the Business Portal installation 
program. For more information, refer to the Order Management documentation.

You can install Catalog Maintenance before installing Business Portal. However, you will 
encounter errors when opening Catalog Maintenance if Business Portal has not yet been 
installed. You must install Business Portal before opening Catalog Maintenance.

Web Services for Microsoft Dynamics GP This component is required if 
you’re installing Business Portal on Office SharePoint Server. The Microsoft 
Dynamics GP web service is used to integrate Microsoft Dynamics GP data into the 
Business Data Catalog in Office SharePoint Server. 
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Web Services for Microsoft Dynamics GP can be installed from the Microsoft 
Dynamics GP installation media. For more information, refer to the Microsoft 
Dynamics GP Web Services Installation and Administration Guide.

Microsoft SQL Server Reporting Services 2008 This component is 
required for the Business Intelligence feature. The Business Intelligence feature 
contains predefined Reporting Services KPIs and metrics created using Reporting 
Services 2008. Your customer data is displayed in these KPIs and metrics in 
Executive Center dashboard pages. You must install and configure Reporting 
Services 2008, and then deploy Microsoft Dynamics GP Reporting Services reports. 
You also must set up security for Reporting Services reports. For more detailed 
information about installing and setting up Reporting Services for use with 
Microsoft Dynamics GP, go to the Microsoft Dynamics GP 2010 documentation 
resources Web site (http://go.microsoft.com/fwlink/?LinkId=161199) for the most 
current documentation.

Back up SharePoint databases

Be sure to back up the following SharePoint database before installing Business 
Portal. 

• Content (WSS_Content) — the content database that will store the web 
application that Business Portal will be installed to

• Configuration (SharePoint_Config)

Register Business Portal applications

Before you can install Business Portal applications, you must register them in 
Microsoft Dynamics GP. Some applications may require certain back office modules 
to be registered, as well. For more information about entering registration keys, 
refer to your Microsoft Dynamics GP documentation.

http://go.microsoft.com/fwlink/?LinkId=161199 
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Chapter 9: Installing Business Portal
This chapter guides you through the Business Portal installation wizard. This 
information is divided into the following sections:

• Business Portal components
• User accounts for Business Portal
• Install Business Portal
• Start Business Portal

Business Portal components

The following Business Portal components are installed by the installation wizard:

Virtual directory A virtual directory called “BusinessPortal” is created in 
Internet Information Services (IIS). An IIS virtual directory maps to a folder on your 
web server’s hard disk that contains web pages. The virtual directory provides 
security; people who access your web pages won’t be able to determine where the 
files are located on your web server, and therefore can’t modify them.

Program files Business Portal program files are installed on the web server’s 
hard disk.

SQL Server objects SQL Server objects are created in Microsoft SQL Server. 
These objects include the tables that store Business Portal data, and the SQL Server 
credentials that Business Portal uses to retrieve data from your databases.

The Reports Catalog is 
installed only if you’re 
using Business Portal 
with Windows 
SharePoint Services.

Reports Catalog The Reports Catalog enables Business Portal users to view 
Microsoft Dynamics GP reports that have been published to Reports pages in 
Business Portal. You can limit users’ access to reports based on user roles.

The Reports Catalog is a shared folder on a server, plus a SQL table and business 
entity. Reports in the Reports Catalog are static—the data they show is current as of 
the date they were published. You determine how often each report is published.

Report Scheduler is a module you can add to Microsoft Dynamics GP to schedule 
and publish Report Writer reports to the Reports Catalog shared folder. For 
information about installing and setting up Report Scheduler, refer to Chapter 12, 
“Reports Catalog setup.”

User accounts for Business Portal

Business Portal uses several user accounts, some of which you must enter during 
installation.

SharePoint user account
If the Business Portal installation creates the Business Portal web application and 
site collection, you must enter a user account that will be used as the application 
pool identity for the new web application. For more information, see User accounts 
for Windows SharePoint Services on page 30 or User accounts for Office SharePoint 
Server on page 36.
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NT service user account
If you’re installing Order Management, you must enter a user account to run the 
eConnect service. The account must be a member of the DYNGRP role in SQL 
Server for the system and company databases you will use with Order 
Management.

Business Portal SQL user account
You must enter a SQL logon ID to allow Business Portal to access data in SQL 
Server. This logon ID is used continually to access Microsoft Dynamics GP data. For 
more information, see SQL Server logon IDs on page 23.

Business Portal Windows user account
To use all the features of Business Portal, Business Portal must have access to your 
network through a Windows user account. Business Portal automatically uses the 
Network Service account; you can’t choose a different account. This account must 
exist on the Business Portal web server in order to install Business Portal.

The Network Service account automatically has appropriate permissions. In 
addition, Windows manages the password, so you won’t have problems with 
password expiration.

Install Business Portal

Before you install, consider the following:

• We recommend backing up the web.config file before installing Business Portal. 
The web.config file is located at C:\inetpub\wwwroot\wss\
VirtualDirectories\<port number>, where <port number> is the port number of 
the IIS web site where you will install Business Portal.

• We recommend backing up the content (WSS_Content) and configuration 
(SharePoint_Config) databases of SharePoint before installing Business Portal. 
The content database is the database that will store the web application that 
Business Portal will be installed to.

• The web site must use Integrated Windows authentication to complete the 
installation. If necessary, the installation program will change the 
authentication method to Integrated Windows before installing and then revert 
to your original settings when the installation is complete.

• Internet Information Services (IIS) will be reset during the Business Portal 
installation. We recommend that you perform this installation at a time when 
IIS resets will have the least amount of impact on any web applications on this 
server. If you have disabled the IISReset command-line utility, you must enable 
it before installing Business Portal. To enable the IISReset command-line utility, 
click Start > Run and type iisreset /enable, then press ENTER.

Complete the following procedure to install Business Portal. If you have multiple 
web servers, you should perform this procedure on each server. 

1. From the Business Portal intallation media, browse and double-click the 
CDSetup.exe file to open the main Business Portal installation window.

2. Under Install, click Business Portal for Microsoft Dynamics GP.
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3. The End-User License Agreement window appears. Read and accept the terms 
and conditions, then select I accept the terms in the License Agreement, and 
click Next.

4. The Connection Information window appears.

Enter the location of your Microsoft Dynamics GP SQL database.

You also must select the type of authentication that should be used when 
creating the SQL tables and objects that are used by Business Portal. These 
credentials are used only during the installation process.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.

• If you select SQL Authentication, enter a SQL Server administrator ID and 
password. Click Next.

For more information about authentication methods, refer to SQL Server 
authentication methods on page 22.

5. The Select Features window appears. Select the features to install.

Field What to do

SQL Server Name Enter the name of the Microsoft Dynamics GP SQL Server. 
(If a named instance is being used, enter it in 
ServerName\Instance format.)

System Database Enter DYNAMICS.
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The first time you run the installation wizard, the applications you have 
registered in Microsoft Dynamics GP will be selected automatically. For more 
information about installing these applications, refer to Chapter 10, “Additional 
applications.”

When you click a button for a feature, a pop-up menu of options appears. Refer 
to the table for more information about each option.

Click Disk Usage to open the Disk Space Requirements window, where you 
can view the amount of available disk space, and the amount required for 
installation.

6. Specify the folder where you want the Business Portal files installed. The 
default folder is C:\Program Files\Microsoft Dynamics\Business Portal. To 
select a different folder, click Browse.

After you have specified the installation folder, click Next.

7. If you’re installing Business Portal on Office SharePoint Server, Enterprise 
Edition, the Web Services URL window appears.

Option What happens

Will be installed to the local 
hard drive

The selected feature will be installed on the local hard disk. 
(This option installs the feature, but not sub features.)

Entire feature will be installed 
to the local hard drive

Will install the feature and all of its sub features.

Entire feature will be 
unavailable

Will not install the selected feature or sub feature.
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Enter the URL for the Microsoft Dynamics GP web service. Be sure to include 
the port number of the web service, which is typically 48620, in the path (http:/
/<computername>:48620/DynamicsGPService).

The port number 48620 is the default value that is used when the Dynamics GP 
service is installed. If this port value doesn’t work to access the service, you will 
need to contact your administrator to find what port the Dynamics GP service is 
running on.

Click Next.

8. The Web Site Configuration window appears.

Select the URL for an existing site collection where you want to install Business 
Portal. 

If Microsoft Dynamics GP Workflow has been installed on this web server, do not select 
the web site where Workflow was installed. Business Portal and Workflow can’t use the 
same web site.

If you’re installing Business Portal on multiple web servers, you must select the 
same site collection on each server.

Click Next.

9. If you’re installing Order Management, the eConnect COM User window 
appears.
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Enter the account to use to run the eConnect service. The account you enter 
must be a member of the DYNGRP role in SQL Server for the system and 
company databases you’ll use with Order Management.

Click Next.

10. The Business Portal SQL Configuration window appears.

Enter a new or existing SQL Server logon ID and password. Business Portal will 
use these credentials when accessing data from SQL Server. If you’re installing 
Business Portal on multiple web servers, be sure that the same Business Portal 
logon ID and password are used for all web servers.

For more information, refer to SQL Server logon IDs on page 23.

Click Next.

11. The Ready to Install window appears. Click Install. The installation process 
will take some time to complete.

12. The Finish window appears. Click Finish.

The Report Viewer Redistributable might be also installed with Business Portal.

When you’ve finished installing Business Portal, verify that the installation was 
successful. Refer to Start Business Portal on page 53 for information about 
starting Business Portal for the first time.

13. We recommend creating an additional backup of the web.config file after 
installing Business Portal. The web.config file is located at 
C:\inetpub\wwwroot\wss\VirtualDirectories\<port number>, where <port 
number> is the port number of the IIS web site where you installed Business 
Portal.

14. You can continue to configure Business Portal, if needed.
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If you’re installing Business Portal on multiple web servers, we recommend 
completing the setup and configuration of Business Portal on the first web 
server to be sure the installation was successful, and then installing Business 
Portal on subsequent web servers.

Refer to the table for additional installation tasks.

Start Business Portal

Start Business Portal by entering the Business Portal URL in the address field of 
Internet Explorer.

• If you installed Business Portal on the default web site, enter 
http://ServerName/BP in the address field.

• If you installed Business Portal on a port other than 80, enter 
http://ServerName:PortNumber/BP in the address field. 

• If you are using managed paths, enter http://ServerName/ManagedPath/BP in 
the address field. 

If you’ve configured your Business Portal to use Secure Sockets Layer (SSL), use 
“https” instead of “http” in the URL. 

Depending on your Internet Explorer security settings, you may be required to log 
on. When you launch Business Portal for the first time, you will be prompted to 
install ActiveX® components that are needed to use certain Business Portal web 
parts. The MBFWebBehaviors.cab contains the ActiveX components. 

If you are not using User Account Control (UAC), you may be asked to install the 
MBFWebBehaviors.cab multiple times. You can double-click the BusinessPortal-
ActiveX.msi (Business Portal installation media\PreReqs\ActiveXControl) to install 
ActiveX components.

On each computer, the user who launches Business Portal for the first time must 
have access privileges to view and use cabinet (.cab) files. This user also must have 
access rights to the Downloaded Program Files folder. (The folder is typically in the 
Windows.) Typically, members of the Administrators and the Power Users groups 
have these rights.

For information about installing ActiveX components on workstations for members 
of the Users group, refer to Install ActiveX controls on client workstations on page 74. 
For information about using Group Policy or Systems Management Server (SMS) to 
deploy ActiveX components, refer to “Active X Components Install for Microsoft 
Business Portal,” located at https://mbs.microsoft.com/customersource/support/
downloads/servicepacks/bpgpslactivex_msi.htm?printpage=false&stext=active x.

Task Reference

Set up reports, if you’re using 
Business Portal with Windows 
SharePoint Services.

Refer to Chapter 12, “Reports Catalog setup.”

Make changes needed to use Business 
Portal with Terminal Services.

Refer to Chapter 13, “Terminal Services setup.” 

Set up employee workstations. Refer to Chapter 14, “Client configuration.”

https://mbs.microsoft.com/customersource/support/downloads/servicepacks/bpgpslactivex_msi.htm?printpage=false&stext=active x 
https://mbs.microsoft.com/customersource/support/downloads/servicepacks/bpgpslactivex_msi.htm?printpage=false&stext=active x 
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Chapter 10: Additional applications
During the Business Portal installation, you’ll be able to select additional features 
and applications to install. Information about additional Business Portal 
components is divided into the following sections:

• Business Portal additional applications
• Add or remove additional applications

Business Portal additional applications

The following applications are available during the Business Portal installation.

The Field Service Suite 
is available only if 
you’re installing on 
Office SharePoint 
Server, Enterprise 
Edition.

• Field Service Suite
• HRM Self Service Suite (HRM)
• Business Intelligence
• Order Management
• Project Time and Expense
• Requisition Management
• Benefit Self Service
• Certification, License, & Training Manager 

You can also choose to install these components after Business Portal has been 
installed. For more information, refer to Add or remove additional applications.

Add or remove additional applications

Use the installation wizard to add features or applications to your Business Portal 
installation or to remove them.

Before you can install additional Business Portal applications, you must register 
them in Microsoft Dynamics GP. Some applications may require certain back office 
modules to be registered, as well. For more information about entering registration 
keys, refer to your Microsoft Dynamics GP documentation.

Most components require additional setup after they’ve been installed. For more 
information, refer to the documentation for each component that you install.

You must uninstall Benefit Self Service and Certification, License & Training 
Manager before you uninstall Business Portal. (To uninstall, right-click their .msi 
files and select Uninstall.) Uninstalling Business Portal will not automatically 
uninstall Benefit Self Service or Certification, License & Training Manager and you 
won’t be able to uninstall those applications after Business Portal is uninstalled. 
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1. Start the installation wizard. You can use either of the following methods:

• From the Business Portal media on your web server computer, browse and 
double-click the CDSetup.exe file to open the main Business Portal 
installation window. Under Install, click Business Portal for Microsoft 
Dynamics GP.

• Open the Add or Remove Programs control panel, and select Business 
Portal for Microsoft Dynamics GP. Click Change to open the Modify 
Business Portal Installation window.

Click Add/Remove Features.

2. The End-User License Agreement window appears. Read and accept the terms 
and conditions, then select I accept the terms in the License Agreement, and 
click Next.

3. The Connection Information window appears.
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Be sure that the server name and system database are correct, and select the 
type of authentication that should be used when the Business Portal software 
accesses your SQL data.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.

• If you select SQL Authentication, enter the SQL Server administrator’s 
logon ID and password. Click Next.

4. The Select Features window appears.

Select the features to install or uninstall. When you click a button for a feature, a 
pop-up menu of options appears. Refer to the table for more information about 
each option.

Click Disk Usage to open the Disk Space Requirements window, where you 
can view the amount of available disk space, and the amount required for 
installation.

Click Next.

Option What happens

Will be installed to the local 
hard drive

The selected feature will be installed on the local hard disk. 
(This option installs the feature, but not sub features.)

Entire feature will be installed 
to the local hard drive

Will install the feature and all of its sub features. (You 
shouldn’t use this option if any sub features have already 
been installed.)

Entire feature will be 
unavailable

Will remove the selected feature or sub feature.
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5. If you’re installing Order Management, the eConnect COM User window 
appears.

Enter the account to use to run the eConnect service. The account you enter 
must be a member of the DYNGRP role in SQL Server for the system and 
company databases you’ll use with Order Management.

Click Next.

6. If you’re removing components associated with SQL objects, the Remove 
Options window appears.

Select the option if you want to remove data for the feature. Your Microsoft 
Dynamics GP data will be unaffected.

If you’ve installed a component on multiple web servers and are removing the 
component from only one of the servers, do not select the option to remove Business 
Portal data. If you do, the application will not function on the remaining web servers. 

Click Next.

7. The Ready to Install window appears. Click Install. The installation process 
may take several minutes to complete.
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8. The Finish window appears. Click Finish.

9. We recommend creating a backup of the web.config file after installing Business 
Portal applications. The web.config file is located at C:\inetpub\wwwroot
\wss\VirtualDirectories\<port number>, where <port number> is the port 
number of the IIS web site where you installed Business Portal.
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Chapter 11: Troubleshooting the installation
This chapter includes information about problems that might occur when you 
install Business Portal. For additional Business Portal troubleshooting information, 
refer to the Business Portal Administrator’s Guide.

This information is divided into the following sections:

• The Report Center feature failed to activate
• Business Portal navigation doesn’t appear

The Report Center feature failed to activate

The Report Center 
feature is available 
only if you’ve installed 
Business Portal on 
Office SharePoint 
Server, Enterprise 
Edition.

If the Microsoft Dynamics GP web service is unavailable during Business Portal 
installation, you may get the following error: “The Report Center feature can’t be 
activated because the installer is unable to access the Microsoft Dynamics GP web 
service. Activate the Report Center feature after Business Portal has been installed.”

Use the following procedure to activate the Report Center feature.

1. Open a Command Prompt window.

2. Change the working directory to \Program Files\Common Files\Microsoft 
Shared\web server extensions\12\BIN.

3. Type and run the following command:

stsadm -o  activatefeature  -filename BPReportsCenter\feature.xml -url http://
localhost/Reports

For more information about using the stsadm command-line tool, refer to the 
SharePoint documentation. For more information about the Report Center, see the 
Business Portal Administrator’s Guide.

Business Portal navigation doesn’t appear

This procedure applies 
only if you’ve installed 
Business Portal on 
Office SharePoint 
Server, Enterprise 
Edition.

If the Business Portal installation completed successfully, but the Business Portal 
item doesn’t appear in the top link bar, you may need to change navigation settings 
for the site collection.

1. Go to the top-level site in the site collection.

2. Click Site Actions > Site Settings > Modify All Site Settings.

3. Under Look and Feel, click Navigation.

4. In the Subsites and Pages section, click Show subsites.

5. Click OK to save your changes.

For more information about Business Portal navigation, see the Business Portal 
Administrator’s Guide.
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Part 4: Additional setup
This part of the documentation contains explains how to set up reports, Terminal 
Services, and client computers for Business Portal. The following information is 
included:

• Chapter 12, “Reports Catalog setup,” includes information you can use to set 
up the reports you can view with Business Portal.

• Chapter 13, “Terminal Services setup,” describes how to configure Business 
Portal to work with a Terminal Services server.

• Chapter 14, “Client configuration,” provides information about preparing client 
workstations to access Business Portal.
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Chapter 12: Reports Catalog setup
Reports Catalog is 
available only if you’ve 
installed Business 
Portal on Windows 
SharePoint Services.

This chapter describes how to set up the system for publishing reports to the 
Business Portal Reports Catalog. The Reports Catalog enables Business Portal users 
to view Microsoft Dynamics GP reports. 

The Reports Catalog is a file location on a server, plus a SQL table and business 
entity. Reports in the Reports Catalog are static—the data they show is current as of 
the date they were published. Use the Report Scheduler to specify how often each 
report is published. 

For more information about the Reports Catalog and the Report Scheduler, refer to 
the Business Portal Administrator’s Guide and the Report Scheduler manual, which 
is available with Microsoft Dynamics GP.

This information is divided into the following sections:

• The shared folder for reports
• Share a reports folder
• Set up the Report Scheduler
• Change the account used to display reports

The shared folder for reports

When you install Business Portal, sample reports are installed in a shared folder 
(called SampleReports) on the web server. The reports are displayed in Business 
Portal pages by the FileServices component service, which runs under a local 
Windows account named FileServiceUser.

If you want to use the Report Scheduler to publish reports that can be viewed in 
Business Portal, we recommend setting up at least one new shared folder to make 
your reports more secure. (We don’t recommend using the SampleReports folder.) 
You can set up shared folders on the web server, on the Microsoft Dynamics GP 
server, or on a file server on your network. You can set up a separate shared folder 
for each company. For more information, refer to Share a reports folder on page 65.

For more information about setting up the Report Scheduler, refer to the Report Scheduler 
documentation, available with your Microsoft Dynamics GP online manuals.

Share a reports folder

You can set up shared reports folders on the web server, on the Microsoft Dynamics 
GP server, or on a file server on your network. You can set up a separate shared 
folder for each company. Use the following procedure to set up appropriate 
permissions for a shared reports folder.

1. Use Windows Explorer to create the new folder on the server. Your folder can 
have any name or be in any location, as long as it can be shared.

To make your reports more secure, we recommend that you don’t create the shared 
reports folder inside the folder where you installed the Business Portal program files.

2. Right-click the reports folder, and choose Sharing and Security to open the 
FolderName Properties window, (where FolderName is the name of the shared 
folder).
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3. On the Sharing tab, click Share this folder, then click Permissions.

4. Click Add to open the Select Users, Computers, or Groups window.

5. Enter FileServiceUser if the shared reports folder is on the same server as 
Business Portal. If you prefer, you can use a domain account instead of the local 
FileServiceUser account.

If the shared reports folder is not on the Business Portal web server, you must 
use a domain account to access the folder. 

For more information, refer to Change the account used to display reports on 
page 67.

6. Click OK to save the information and close the Select Users, Computers, or 
Groups window.

7. In the Permissions for FolderName window, be sure that FileServiceUser (or the 
account you created) has Read access. Be sure that each Microsoft Dynamics GP 
user who will be publishing reports has Read and Write access to the new 
folder.

To make your data more secure, you should not give “Everyone” or “Authenticated 
Users” privileges on the folder.

Click OK to save the information and close the window.

8. Click OK to close the FolderName Properties window.

9. Follow the instructions in Set up the Report Scheduler on page 66 for next steps.

Set up the Report Scheduler

After you’ve created a shared reports folder, you must set up the Report Scheduler 
by specifying shared folders in Microsoft Dynamics GP. You can specify separate 
shared folders for each company.

1. In Microsoft Dynamics GP, open the Report Schedule window.
Microsoft Dynamics GP > Tools > Routines > Company > Report Schedule

2. Enter or select the new shared folder for the Publish to Location.

The path you enter must be in UNC format, such as 
\\ServerName\ShareName.

3. Click Apply and close the window.

For information about the other options in the Report Schedule window, see the Report 
Scheduler help. (With the window open in Microsoft Dynamics GP, press F1.)
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Change the account used to display reports

Use this procedure to set up your Business Portal system to access the shared 
reports folder using an account other than FileServiceUser.

1. On the web server, open Component Services.
Start > Administrative Tools > Component Services

2. In the left pane, expand Component Services > Computers > My Computer > 
COM+ Applications.

3. Right-click on Microsoft.BusinessPortal.Reports.FileService and select 
Properties to open the Microsoft.BusinessPortal.FileService Properties window.

4. Click the Identity tab. 

5. In the User field, enter the account you want the COM+ application to use to 
access the shared reports folder. We recommend that this account be used only 
for the COM+ application.

6. Enter and confirm the password for the account.

7. Click OK to save your changes and close the window.
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Chapter 13: Terminal Services setup
After installing Business Portal on your web server, you can use the information in 
this chapter to set up access to Microsoft Dynamics GP windows through Terminal 
Services. This is useful for remote users or users who need access to Microsoft 
Dynamics GP information only occasionally. 

The following sections are included:

• Terminal Services server requirements
• Terminal Services for Business Portal setup checklist
• Configure the Terminal Services server for Business Portal
• Set up Terminal Services access in Business Portal

Terminal Services server requirements

Refer to the Microsoft Dynamics GP documentation web site (http://
go.microsoft.com/fwlink/?LinkId=161197) to get the latest requirements for using 
Terminal Services with the Microsoft Dynamics GP application.

To use Terminal Services with Windows Server 2008, install the Terminal Services server 
role and its role services using Server Manager. 

Terminal Services for Business Portal setup checklist

After you’ve installed Business Portal on a web server, you’ll need to complete the 
following steps to open Microsoft Dynamics GP windows in Business Portal.

Your Terminal Services server must be running the Microsoft Dynamics GP back 
office application before it is added to the Business Portal configuration. For 
information about how to install and set up Terminal Services, refer to your 
Windows documentation.

Refer to the table for more information.

Task Reference

If you are using Windows 
Server 2003, install 
Terminal Services 
Advanced Client on the 
web server.

Terminal Services Advanced Client is an ActiveX control which is 
part of the Windows Server 2003 Administration Tools Pack. You 
can download the tools pack from the Microsoft web site: 
www.microsoft.com/downloads/ > Server Applications > 
Windows Server 2003 Administration Tools Pack.

If you are using Windows 
Server 2008 and 
RemoteApp programs, 
Remote Desktop 
Connection (RDC) 6.0 and 
RDC 6.1 must be installed 
on your client computers. 

RDC 6.0 and RDC 6.1 must be installed on your client computers to 
access Microsoft Dynamics GP using RemoteApp programs. A 
supported version of the RDC client is included with Windows 
Server 2008. To install RDC 6.0 or RDC 6.1, you can use Server 
Manager to add Desktop Experience as a feature.

Configure the Terminal 
Services server to work 
with Business Portal.

Refer to Configure the Terminal Services server for Business Portal 
on page 70 for more information.

On the Terminal Services 
server, set up an ODBC 
data source for thin-client 
access to the Microsoft 
Dynamics GP application.

Refer to your Microsoft Dynamics GP documentation.

http://go.microsoft.com/fwlink/?LinkId=161197
http://go.microsoft.com/fwlink/?LinkId=161197
http://www.microsoft.com/downloads


P A R T  4 A D D I T I O N A L  S E T U P

70 I N S T A L L A T I O N G U I D E

If you’re installing Business Portal on multiple web servers, you must install the 
Terminal Services Client on each of the web servers, but you need to enter the name 
of the Terminal Services computer in only one instance of Business Portal. (The 
information automatically is shared by the web servers.)

Configure the Terminal Services server for Business 
Portal

To use thin-client access to open Microsoft Dynamics GP windows in Business 
Portal, you’ll need to configure the Terminal Services server.

1. Start the Terminal Services Configuration tool.
Start > Administrative Tools > Terminal Services Configuration

2. In the right pane, select RDP-Tcp, then select Action > Properties to open the 
RDP-Tcp Properties window.

3. Click the Sessions tab.

4. Select the first Override user settings option, and choose 1 minute.

5. Select the second Override user settings option. Select End session.

6. Click OK to save your settings and close the window.

In Business Portal, enter 
the name of the Terminal 
Services server and the 
path to the Microsoft 
Dynamics GP application.

Refer to Set up Terminal Services access in Business Portal on 
page 71.

Task Reference
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Set up Terminal Services access in Business Portal

Use the E-mail and Terminal Services page in Business Portal to select options for 
Microsoft Dynamics GP access. When you specify the initial program and working 
directory through this page, Microsoft Dynamics GP opens by default for only those 
users who access the server through Business Portal.

We don’t recommend specifying the initial program and working directory through 
Windows Terminal Services; this opens Microsoft Dynamics GP by default for every 
user who logs on to the server. 

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click E-mail and Terminal Services. 
The E-mail and Terminal Services page appears.

3. Specify the Windows Terminal Server to use for Internet Explorer access to 
Microsoft Dynamics GP.

4. Type the path and filename of the Microsoft Dynamics GP application, which 
will start when a user logs on to WTS, using the following format:

“C:\PathName\dynamics.exe” “C:\PathName\dynamics.set”

PathName is the path to the Microsoft Dynamics GP application. (Make sure to 
include the quotation marks.)

5. Type the path to the working directory where Microsoft Dynamics GP should 
run, using the following format:

C:\PathName

PathName is the path to the Microsoft Dynamics GP application.

6. Click Save.
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Chapter 14: Client configuration
This chapter contains procedures you must perform on client workstations to 
prepare them to use Business Portal. The following sections are included:

• Set browser settings for a workstation
• Install ActiveX controls on client workstations
• Pop-up blockers and Business Portal
• Install Microsoft Office XP Web Components

Set browser settings for a workstation

Be sure that the Internet Explorer options for employee workstations are set so 
content is refreshed. Also, Internet Explorer security should be set up so that 
ActiveX controls are allowed to run on the Business Portal web site. If ActiveX 
controls are not allowed to run, users won’t be able to use result viewer web parts.

Internet Explorer options are set for each user on a single computer. If multiple 
users share a single client workstation, these settings will need to be made with each 
of the users logged on to the workstation.

For information about changes you can make to improve workstation performance, refer to 
the Business Portal Administrator’s Guide. 

To set browser settings in Internet Explorer 7.0or Internet 
Explorer 8.0:
1. Start Internet Explorer and open the Internet Options window.

Tools > Internet Options

2. Click the General tab. Under Browsing history, click Settings.

3. The Temporary Internet Files and History Settings window is displayed. Be 
sure the Check for newer versions of stored pages option is not set to Never.

4. Click OK to close the settings window.

5. Click the Security tab, highlight Trusted Sites, and click Sites to open the 
Trusted Sites window.

If Business Portal doesn’t use Secure Sockets Layer, you must clear the Require server 
verification (https) for all sites in this zone check box. If you can’t clear the check 
box, you must change the security settings for the Local Intranet zone instead of adding 
Business Portal to your Trusted Sites list.

6. In Add this Web site to the zone, enter the Business Portal URL and click Add.

7. Click OK to close the Trusted Sites window.

8. In the Internet Options window, be sure Trusted Sites is still selected and click 
Custom Level to open the Security Settings window.
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9. In the ActiveX controls and plug-ins section, select Enable for the following 
settings:

• Download signed ActiveX controls
• Initialize and script ActiveX controls not marked as safe for scripting
• Run ActiveX controls and plug-ins

Changing these options will allow ActiveX controls to run automatically on all 
web sites in your Trusted Sites zone. This zone contains sites that you believe 
you can download or run files from without worrying about damage to your 
computer or data. The security level for trusted sites is typically lower than the 
general Internet or Intranet security level.

10. Click OK. An alert message will be displayed, asking if you’re sure that you 
want to change the security settings for the zone. Click Yes.

11. Click OK to close the Internet Options window.

Install ActiveX controls on client workstations

When users launch Business Portal for the first time on client workstations, they 
may be prompted to install ActiveX components that are needed to use certain 
Business Portal web parts.

To install ActiveX components, the user logged on to the workstation must have 
write access to the Downloaded Program Files folder (typically located in the 
Windows folder) and to the registry. On Windows XP computers, members of the 
Administrators and the Power Users groups typically have these rights. (The Users 
group typically has only read access in order to allow administrators to better 
control software installation.)

If your Business Portal users are in the Administrators or Power Users groups on 
their workstations, you don’t need to take any action. The ActiveX controls will be 
installed automatically.

To install ActiveX controls for those in the Users group, or for those who do not 
have installation rights on their computers, a Windows Installer package file is 
available on the Business Portal  in the \PreReqs\ActiveXControl folder. If your 
users don’t have installation rights on their computers, you can install the controls 
using a software distribution tool such as Systems Management Server.

If you can’t install the ActiveX controls using the installation package, we 
recommend logging on to each workstation as a member of the Power Users or 
Administrators group, then launching Business Portal to download the ActiveX 
controls. Once a member of the Power Users group or the Administrators group has 
downloaded the components, those components will be available to members of the 
Users group.

Pop-up blockers and Business Portal

Pop-up blocker software on client computers may interfere with some Business 
Portal pages. We recommend configuring pop-up blockers to allow pop-ups within 
the Business Portal URL. If your pop-up blocker doesn’t provide this option, we 
recommend removing or disabling pop-up blocker software on Business Portal 
client workstations.
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Install Microsoft Office XP Web Components

In order to export information to Excel from a Business Portal client computer, 
Microsoft Office XP Web Components must be installed, regardless of the version of 
Office you're using. 

The Office XP Web Components (owc10.exe) can be downloaded from the Microsoft 
Download Center (www.microsoft.com/downloads). 

http://www.microsoft.com/downloads
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Part 5: Extranet deployment
This part of the documentation describes supported extranet configurations and 
provides recommended settings to run Business Portal in an extranet environment. 
The following information is discussed.

• Chapter 15, “Extranet environments,” contains recommendations for setting up 
Business Portal in an extranet environment. Two scenarios are described: 
extranet access through a single Internet Security and Acceleration (ISA) server, 
and extranet access through back-to-back ISA servers.

• Chapter 16, “ISA Server configuration,” lists the communication rules and 
policies that should be set up for Business Portal. The recommendations are for 
ISA Server. However, if you already have an extranet that doesn’t use ISA 
Server, the rules and policies in this chapter can be applied on whatever 
hardware and software you are using.
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Chapter 15: Extranet environments
This chapter provides recommendations for deploying Business Portal in an 
extranet. An extranet, or perimeter network, is an extension of your company’s 
intranet that provides limited access to authorized outside users.

The term “perimeter network” refers to a network that lies between the intranet and 
the Internet. It is a network that separates a trusted network (the intranet) from a 
network that is not trusted (the Internet). Perimeter networks are typically, but not 
always, physical networks. Perimeter networks are also known as screened subnets.

All of the configurations in this chapter use Microsoft Internet Security and 
Acceleration Server (ISA Server) to create a perimeter network. If your company has 
an existing perimeter network that doesn’t use ISA Server, we recommend that you 
use hardware and software with similar functionality. In addition, you should set 
up the same communication rules and policies as recommended for ISA Server. For 
more information, refer to Chapter 16, “ISA Server configuration.”

The information is divided into the following sections:

• Extranet deployment overview
• Extranet access through a single ISA server
• Extranet access through back-to-back ISA servers

Extranet deployment overview

Deploy Business Portal in an extranet if employees will use home computers to 
access Business Portal through the Internet, or if external users, such as customers 
and vendors, will access Business Portal from their own networks.

Some Business Portal server configurations are not appropriate for extranet use. For 
more information about Business Portal configurations that can be deployed in an 
extranet, refer to Chapter 2, “Business Portal configurations.” 

To help protect your data, we strongly recommend using Secure Sockets Layer (SSL) for 
your Business Portal web site if it is deployed externally.

Deployment scenarios
There are two basic extranet deployment scenarios for Business Portal. 

Tri-homed perimeter network In this scenario, a single ISA Server computer 
is used to communicate between your internal network and the Internet. This 
configuration is also known as a single-screened subnet. For more information, see 
Extranet access through a single ISA server on page 80.

Back-to-back perimeter network In this scenario, back-to-back ISA Server 
computers are used to communicate between your internal network and the 
Internet. This configuration is also known as a dual-screened subnet. For more 
information, see Extranet access through back-to-back ISA servers on page 81.
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Extranet users
Business Portal users can be classified as either internal or external. Internal users 
are employees of your company. External users are people outside of your 
organization, such as your customers and vendors. Both types of users can access 
Business Portal through an extranet.

Once you've set up Business Portal in an extranet, you should create pages for 
external users such as customers. (Business Portal does not include pages for the BP 
Customer SharePoint group by default, unless you’re using the Order Management 
application.) For information about creating a customer portal, refer to the Business 
Portal Administrator's Guide.

All Business Portal users—both internal and external—must have valid Windows 
domain accounts; Business Portal does not support anonymous users. For 
guidelines about setting up external users, refer to the Business Portal 
Administrator's Guide.

Extranet access through a single ISA server

The following illustration shows how your network could be set up to provide 
access to Business Portal through a single ISA server. The ISA server in this scenario 
must have three network cards—one for the external network (Internet), one for the 
internal network (intranet), and one for the perimeter network. All of the computers 
in this scenario are on the same domain.

The primary risk with a single ISA server configuration is that it constitutes a single 
point of failure. If the ISA server is compromised, an intruder could gain access to 
your internal network.

Corporate Intranet

Internet

Perimeter Network

ISA Server

Business Portal 

Web server

Domain controllerSQL Server
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In this configuration, you can deploy Business Portal in several ways. For example, 
you can deploy:

• One Business Portal server in the perimeter network for both internal and 
external access.

• One Business Portal server in the perimeter network for external access and one 
server in the intranet for internal access.

• Multiple Business Portal servers in the perimeter network for both internal and 
external access. 

• Multiple Business Portal servers in the perimeter network for external access 
and multiple servers in the intranet for internal access. 

You can use multiple server farms to separate functionality used by internal and 
external Business Portal users, if necessary. For more information, see Multiple server 
farms configuration on page 16.

For more information about the rules and policies for the ISA Server in this 
configuration, see Rules and policies for a single ISA server on page 83 and Rules and 
policies for publishing a web server on a perimeter network on page 86.

Extranet access through back-to-back ISA servers

The following illustration shows how your network could be set up to provide 
access to Business Portal through back-to-back ISA servers. In this configuration, 
the perimeter network and the intranet are on separate domains.

This scenario is typically considered more secure than the single ISA server 
scenario. If the external ISA server were compromised, the internal ISA server 
would still help protect your intranet. However, a higher cost is associated with this 
scenario because additional servers are needed. There is also additional setup 
complexity.

Corporate IntranetInternet

Domain controller

Internal ISA Server

SQL ServerBusiness Portal 

Web server
Domain controller

Perimeter Network

External ISA Server
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In this configuration, you can deploy Business Portal in several ways. For example, 
you can deploy:

• One Business Portal server in the perimeter network for both internal and 
external access.

• One Business Portal server in the perimeter network for external access and one 
in the intranet for internal access.

• Multiple Business Portal servers in the perimeter network for both internal and 
external access.

• Multiple Business Portal servers in the perimeter network for external access 
and multiple servers in the intranet for internal access.

You can use multiple server farms to separate functionality used by internal and 
external Business Portal users, if necessary. For more information, see Multiple server 
farms configuration on page 16.

In your implementation, a trust may be set up between the two domains, or the 
perimeter network could belong to the internal domain. Communication rules and 
policies between servers should be adjusted accordingly. 

For more information about the rules and policies for back-to-back ISA servers, 
refer to Rules and policies for back-to-back ISA servers on page 84 and Rules and policies 
for publishing a web server on a perimeter network on page 86.
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Chapter 16: ISA Server configuration
Microsoft Internet Security and Acceleration (ISA) Server is a firewall, virtual 
private network (VPN), and web cache solution that simplifies network security 
and performance. You can give external clients limited access to your intranet 
through an ISA server. 

ISA Server performs many of the same functions as a firewall in determining who 
should have access to certain pieces of information. ISA Server helps prevent 
disclosure of internal IP addresses, computer names, and domain names. ISA Server 
will allow only authorized traffic, and it will help detect and prevent intrusions 
such as hacking and viruses. 

For more information about ISA Server, including a hardening guide, refer to the 
ISA Server home page on Microsoft’s web site (www.microsoft.com/isaserver).

This chapter explains the ISA Server settings that are needed to run Business Portal 
in an extranet environment. Recommendations for a single ISA server and for back-
to-back ISA servers are included.

You can set up ISA servers either before or after you have installed Business Portal.

The information is divided into the following sections:

• Rules and policies for a single ISA server
• Rules and policies for back-to-back ISA servers
• Rules and policies for publishing a web server on a perimeter network
• Using a named instance of SQL Server in an extranet

Rules and policies for a single ISA server

You can specify how computers on each network communicate with each other by 
way of the ISA server. The table below defines the relationship rules and policies 
that are required to run Business Portal in an extranet environment with a single 
ISA server. For more information about this configuration, refer to Extranet access 
through a single ISA server on page 80.

Type Source Destination Port Comments

Access rule Business Portal web server SQL server (Microsoft 
Dynamics GP)

1433 Could be a different port as defined 
for the SQL server.

Access rule Business Portal web server SQL server (SharePoint) 1433 Optional, if the SharePoint server is 
not the same as the Microsoft 
Dynamics GP server or the web 
server. Could be a different port as 
defined for the SQL server.

Access rule Business Portal web 
server, ISA server

Domain controller All outbound 
traffic

Access rule Domain controller Business Portal web server, 
ISA server

All outbound 
traffic

Access rule Internal network Business Portal web server 443 Internal client https access to 
Business Portal

Access rule Internal network Business Portal web server 
or perimeter network file 
server

445 Optional, for publishing reports to a 
shared folder. Could be limited to 
only the Microsoft Dynamics GP 
client publishing reports.

http://www.microsoft.com/isaserver/
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Rules and policies for back-to-back ISA servers

The tables below define the relationship rules and policies that are required to run 
Business Portal in an extranet environment with back-to-back ISA servers. For more 
information about this extranet configuration, refer to Extranet access through back-to-
back ISA servers on page 81.

• The following rules and policies assume that the perimeter network and the 
internal network are on separate domains. If the perimeter network is on the 
internal domain, you must open all ports between the web server and the 
intranet domain controller and between the ISA server and the intranet domain 
controller.

• The following rules and policies assume that the perimeter network’s domain 
trusts the internal domain. If a trust is not set up between the two domains, no 
ports need to be open for traffic between the two domain controllers. (In this 
situation, a user on the intranet domain would be required to access Business 
Portal using an account that exists on the perimeter network domain.)

External ISA Server rules
The external ISA Server handles communication between the perimeter network 
and the Internet. Create the following rules.

Access rule Business Portal web server SMTP server 25 Optional, for sending e-mail from 
Business Portal or SharePoint. 
Required if using Electronic 
Document Delivery.

Access rule Business Portal web server Internal network file server 445 Optional, for publishing reports to a 
file share on the internal network. 
Do not allow inbound traffic from 
the Internet.

Publish rule Internet Business Portal web server 443 External client https access to 
Business Portal

Network rule ISA server All networks n/a Relation - Route

Network rule-Route Internal network Perimeter network n/a Relation - Route

Network rule-Route Perimeter network Internet n/a Relation - NAT

Network rule-Route Perimeter network Internal network n/a Relation - Route

Type Source Destination Port Comments

Type Source Destination Port Comments

Access rule Business Portal web server SQL server (Microsoft 
Dynamics GP)

1433 Could be a different port as defined for 
the SQL server.

Access rule Business Portal web server SQL server (SharePoint) 1433 Optional, if the SharePoint server is 
not the same as the Microsoft 
Dynamics GP server or the web server. 
Could be a different port as defined for 
the SQL server.

Publish rule Internet Business Portal web server 443 External client https access to Business 
Portal

Network 
rule

ISA server Internet, perimeter network n/a Relation - Route

Network 
rule - Route

Perimeter network Internet n/a Relation - NAT
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Internal ISA Server rules
The internal ISA Server handles communication between the perimeter network 
and your intranet. Create the following rules.

Type Source Destination Port Comments

Access rule Business Portal web server SQL server (Microsoft 
Dynamics GP)

1433 Could be a different port as defined for 
the SQL server.

Access rule Business Portal web server SQL server (SharePoint) 1433 Optional, if the SharePoint server is 
not the same as the Microsoft 
Dynamics GP server or the web server. 
Could be a different port as defined for 
the SQL server.

Access rule Internal network domain 
controller

Perimeter network domain 
controller

All outbound traffic

Access rule Perimeter network domain 
controller

Internal network domain 
controller

All outbound traffic

Access rule Internal network Business Portal web server 443 Internal client https access to Business 
Portal. Optional if internal clients 
access Business Portal on the 
perimeter network.

Access rule Internal network Business Portal web server 
or perimeter network file 
server

445 Optional, for publishing reports to a 
shared folder. Could be limited to only 
the Microsoft Dynamics GP client 
publishing reports.

Access rule Business Portal web server SMTP server 25 Optional, for sending e-mail from 
Business Portal or SharePoint. 
Required if using Electronic Document 
Delivery.

Access rule Business Portal web server Internal network file server 445 Optional, if publishing reports to a file 
share on the internal network. Do not 
allow inbound traffic from the Internet.

Network 
rule

ISA server Perimeter network, internal 
network

n/a Relation - Route

Network 
rule - Route

Internal network Perimeter network n/a Relation - Route

Network 
rule - Route

Perimeter network Internal network n/a Relation - Route
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Rules and policies for publishing a web server on a 
perimeter network

The following table provides information for publishing a secure web server on a 
perimeter network.

For more information about publishing a web server on a perimeter network using 
ISA Server, refer to Microsoft KnowledgeBase article 838242. (Go to 
support.microsoft.com and type 838242 in the Search box.)

Using a named instance of SQL Server in an extranet

If you install the SharePoint or Microsoft Dynamics GP databases on a named 
instance of SQL Server, additional setup steps are required.

1. Set up an alias for the named instance using the Client Network Utility. 
Configure the alias to use the port assigned to the named instance of SQL 
Server.

For more information about the Client Network Utility, see SQL Server Books 
Online.

2. When setting up access rules from the web server to the SQL server, replace 
port 1433 with the port configured for the alias.

For more information about the access rules needed to deploy Business Portal 
in an extranet, refer to Rules and policies for a single ISA server on page 83 and 
Rules and policies for back-to-back ISA servers on page 84.

3. Create a DNS entry for the alias, or add an entry to the IIS server’s hosts file.

Publish a secure web server 
rule

Property Setting

Publishing mode SSL bridging

Rule action Allow

Bridging mode Secure connection to clients

Web site to publish Business Portal web server name

Public name details External URL or public name

User sets Default

Publish a secure web server 
properties

From Internet

Traffic Filter > Configure http
Verify normalization = false

Link translation On an internal ISA server: Replace absolute links in web pages = false
On an external ISA server: Replace absolute links in web pages = true

Web listener properties Disable http Enable http = false

Enable SSL Enable SSL = true
Select certificate

Authentication Integrated or Basic

http://support.microsoft.com
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4. If Business Portal has already been installed, edit the SQL server name in the 
~privatefiledbauthentication.config and BusinessFramework.config files using 
the format AliasName,PortNumber. 

These configuration files are located in the Business Portal bin folder. (The bin 
folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories\<port 
number>, where <port number> is the port number of the IIS web site where 
Business Portal is installed.)

If Business Portal has not yet been installed, enter the SQL server name using 
the format AliasName,PortNumber in the Connection Information window of the 
installation wizard. No further configuration is necessary.
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Appendix
This appendix contains information about setting up Business Portal for 
demonstration purposes. The following information is included:

• Appendix A, “Demonstration or development configuration,” explains how to 
set up Business Portal on a single computer for demonstration or development 
purposes.
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Appendix A: Demonstration or development 
configuration
This appendix describes the appropriate configuration for a demonstration or 
development environment. In a demonstration or development environment, 
Business Portal, SQL Server, and Microsoft Dynamics GP can be installed on a 
single computer.

The configuration described below is not recommended or supported for use in a 
production environment.

Setting up a demonstration or development 
configuration

Use the following instructions to install Business Portal on a single computer for 
demonstration or development purposes.

In a demonstration or development configuration, your computer functions as a 
SQL database server and a web server. It stores all your business management 
information, and hosts your Business Portal web site.

1. Log on to the computer as the local administrator.

2. Install Internet Information Services (IIS).
Control Panel > Add/Remove Programs > Add/Remove Windows 
Components > Application Server > Details

Mark ASP.NET, Enable network COM+ access, and Internet Information 
Services.

3. Install Microsoft SQL Server and the Microsoft Dynamics GP application. For 
more information, refer to the Microsoft Dynamics GP installation guide.

4. Install Windows SharePoint Services or Office SharePoint Server using the Basic 
method. For more information, refer to Windows SharePoint Services installation 
considerations on page 29 or Office SharePoint Server installation considerations on 
page 35.

5. If you need to turn on Secure Sockets Layer (SSL) for the web site, you can use 
the SelfSSL tool, which is part of the Internet Information Services (IIS) 6.0 
Resource Kit. The SelfSSL tool generates and installs a self-signed Secure 
Sockets Layer (SSL) certificate. 

Because SelfSSL.exe generates a self-signed certificate that does not originate from a 
commonly trusted source, use this tool only in a demonstration or development 
environment.

After installing the certificate, use IIS Manager to display the properties for the 
web site. In the properties window, click Directory Security. Under Secure 
communications, click Edit. In the Secure Communications window, mark 
Require secure channel (SSL).
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6. Install Business Portal. For more information, refer to Chapter 9, “Installing 
Business Portal.”

7. If the computer will not be connected to a network, perform the following steps:

• Install the Microsoft Loopback Adapter. For more information, refer to 
Microsoft KnowledgeBase article 842561. (Go to support.microsoft.com and 
type 842561 in the Search box.) 

• Open the Hosts file located in C:\WINNT\system32\drivers\etc using 
Notepad. Add the loopback IP address and your computer name, as in the 
following example:

127.0.0.1 localhost
127.0.0.1 ComputerName

The localhost entry typically already exists. Add a second entry with the 
same IP address and replace ComputerName with your computer name. 

• Make a copy of the LMhosts.sam file located in 
C:\WINNT\system32\drivers\etc. Rename the file LMhosts (no file 
extension). Then open the file in Notepad and add the loopback IP address 
and your shared reports folder location to the bottom of the file, as in the 
following example: 

127.0.0.1 \\ComputerName\ReportsShare

http://support.microsoft.com
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